
OpenShot Video Editor Documentation
Release 3.1.1

OpenShot Studios, LLC

Feb 19, 2024



CONTENTS

1 Table of Contents: 2
1.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.2 Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.3 Quick Tutorial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
1.4 Video Editing Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
1.5 Main Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
1.6 Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
1.7 Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
1.8 Transitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
1.9 Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
1.10 Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
1.11 Animation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
1.12 Text & Titles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
1.13 Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
1.14 Import & Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
1.15 Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
1.16 Playback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
1.17 Developers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
1.18 Contributing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
1.19 Learn More . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
1.20 Glossary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

i



OpenShot Video Editor Documentation, Release 3.1.1

OpenShot Video Editor is an award-winning, open-source video editor, available on Linux, Mac, Chrome OS, and
Windows. OpenShot can create stunning videos, films, and animations with an easy-to-use interface and rich set of
features.
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TABLE OF CONTENTS:

1.1 Introduction

OpenShot Video Editor is an award-winning, open-source video editor, available on Linux, Mac, and Windows. Open-
Shot can create stunning videos, films, and animations with an easy-to-use interface and rich feature-set.

1.1.1 Features

• Free & open-source (licensed under GPLv3)

• Cross-platform (Linux, OS X, Chrome OS, and Windows)

• Easy-to-use UI (beginner-friendly, built-in tutorial)

• Supports most formats (video, audio, images - FFmpeg-based)

• 70+ video profiles & presets (including YouTube HD)

• Advanced timeline (drag-drop, scroll, zoom, snap)

• Advanced clips (trim, alpha, scale, rotate, shear, transform)
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• Real-time preview (multi-threaded, performance-optimized)

• Simple & advanced views (customizable)

• Keyframe animations (linear, Bézier, constant interpolation)

• Compositing, overlays, watermarks, transparency

• Unlimited tracks / layers (for complex projects)

• Transitions, masks, wipes (grayscale images, animated masks)

• Video & audio effects (brightness, hue, chroma key, and more)

• Image sequences & 2D animations

• Blender 3D integration (animated 3D title templates)

• Vector file support & editing (SVG for titles)

• Audio mixing, waveform, editing

• Emojis (open-source stickers & artwork)

• Frame accuracy (per-frame navigation)

• Time re-mapping & speed changes (slow/fast, forward/backward)

• Advanced AI (motion tracking, object detection, stabilization)

• Credits & captions (scrolling, animated)

• Hardware acceleration (NVIDIA, AMD, Intel, etc.)

• Import & export (EDL, Final Cut Pro)

• Desktop integration (drag-drop from file managers)

• JSON project format (OpenShot Cloud API compatible)

• Customizable shortcuts

• Translations (100+ languages)

• Community support (Visit our forum)

1.1. Introduction 3
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1.1.2 Screenshot

1.1.3 System Requirements

Video editing benefits from modern, multi-core CPUs with fast clock speeds (GHz), large amounts of memory, and
fast hard disk drives. Basically, you want the best computer you can afford when video editing. Here are the minimum
system requirements:

1.1. Introduction 4
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TL;DR

Most computers manufactured after 2017 will run OpenShot

Minimum Specifications

• 64-bit Operating System (Linux, OS X, Chrome OS, Windows 7/8/10/11)

• Multi-core processor with 64-bit support

– Minimum cores: 2 (recommended: 6+ cores)

– Minimum threads: 4 (recommended: 6+ threads)

– Minimum turbo clock speed: 2.7 Ghz (recommended: 3.4+ Ghz)

• 4GB of RAM (16+ GB recommended)

• 1 GB of hard-disk space for installation & usage (recommended: 50+ GB available hard-disk space for media,
videos, images, and storage)

• Optional: Solid-state drive (SSD), if utilizing disk-caching add an additional 10GB of hard-disk space

• For factors related to real-time previews, see Playback.

1.1.4 License

OpenShot Video Editor is free software: you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation, either version 3 of the License, or (at your option) any
later version.

OpenShot Video Editor is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License for more details.

1.2 Installation

The latest official stable version of OpenShot Video Editor for Linux, Mac, Chrome OS, and Windows can be down-
loaded from the official download page at https://www.openshot.org/download/. You can find our latest unstable
versions (i.e. daily builds) at https://www.openshot.org/download#daily (these versions are updated very frequently,
and often contain many improvements not yet released in our stable build).

1.2.1 Clean Install

If you are upgrading from a previous version of OpenShot or are experiencing a crash or error message after launching
OpenShot, please see Reset (Default Values) for instructions on clearing the previous openshot.settings file (for a
clean install with default preferences).

1.2. Installation 5
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1.2.2 Windows (Installer)

Download the Windows installer from the official download page (the download page contains both 64-bit and 32-bit
versions), double click it, and follow the directions on screen. Once completed, OpenShot will be installed and available
in your Start menu.

1.2.3 Windows (Portable)

If you need to install OpenShot on Windows without Administrator permissions, we also support a portable installation
process. Download the Windows installer from the official download page, open the command prompt, and type the
following commands:

1.2. Installation 6
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Listing 1: Install portable version of OpenShot (no administrator permis-
sions required)

cd C:\Users\USER\Downloads\
OpenShot-v2.6.1-x86_64.exe /portable=1 /currentuser /noicons

1.2.4 Mac

Download the DMG file from the official download page, double click it, and then drag the OpenShot application
icon into your Applications shortcut. This is very similar to how most Mac applications are installed. Now launch
OpenShot from Launchpad or Applications in Finder.

1.2. Installation 7
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1.2.5 Linux (AppImage)

Most Linux distributions have a version of OpenShot in their software repositories, which can be installed using your
package manager / software store. However, these packaged versions are often very outdated (be sure to check the
version number: Help→About OpenShot). For this reason, we recommend installing an AppImage from the official
download page.

Once downloaded, right click on the AppImage, choose Properties, and mark the file as Executable. Finally, double
click the AppImage to launch OpenShot. If double clicking does not launch OpenShot, you can also right click on the
AppImage, and choose Execute or Run. For a detailed guide on installing our AppImage and creating a launcher for it,
see our AppImage Installation Guide.

1.2.6 Linux (PPA)

For Debian-based Linux distributions (Ubuntu, Mint, etc. . . ), we also have a PPA (Personal Package Archive), which
adds our official OpenShot software repository to your package manager, making it possible to install our latest version,
without relying on our AppImages.

Listing 2: Stable PPA (Contains only official releases)

sudo add-apt-repository ppa:openshot.developers/ppa
sudo apt update
sudo apt install openshot-qt python3-openshot

1.2. Installation 8
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Listing 3: Daily PPA (Highly experimental and unstable, for testers)

sudo add-apt-repository ppa:openshot.developers/libopenshot-daily
sudo apt update
sudo apt install openshot-qt python3-openshot

1.2.7 Chrome OS (Chromebook)

Chrome OS supports Linux apps, but this feature is off by default. You can turn it on in Settings. Once Linux is
enabled, you can install and run OpenShot Linux AppImages on any x86-based Chromebook. The command below
will download our AppImage and configure your system to run OpenShot successfully.

• Navigate to chrome://os-settings/crostini (Copy/Paste)

• Under “Linux (Beta)” select “Turn On”. Default values are fine.

• When the Terminal appears (i.e. black window), Copy/Paste the following command:

– bash <(wget -O - http://openshot.org/files/chromeos/install-stable.sh)

1.2.8 Uninstall

To fully uninstall OpenShot from your system, you must manually delete the .openshot_qt folder: ~/.
openshot_qt/ or C:\Users\USERNAME\.openshot_qt\, which contains all settings and files used by OpenShot.
Be sure to backup any recovery files of your existing projects first (*.osp files). Please see Reset (Default Values) for
instructions on clearing the previous openshot.settings file (for a clean install with default preferences).

Windows

1. Open Control Panel from the Start menu

2. Click on Programs and Features

3. Select OpenShot Video Editor, then click Uninstall

Mac

1. Open Finder and go to Applications

2. Drag the OpenShot Video Editor icon to the Trash in the Dock

3. Right-click Trash and choose Empty Trash

Ubuntu (Linux)

1. Open up Files

2. Locate the *.AppImage and delete the file

3. OR click Activities, Right-click on OpenShot Video Editor icon, and choose Remove AppImage from System

1.2. Installation 9
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1.3 Quick Tutorial

Using OpenShot is very easy, and this tutorial will take you through the basics in under 5 minutes. After this tutorial,
you will be able to make a simple photo slide-show with music.

1.3.1 Basic Terminology

To help understand the steps below, here are some definitions of a few basic terms used in this tutorial.

Term Description
Project A project includes references to all the video files and edits (animations, titles, etc. . . ), saved

in a single file.
Timeline The timeline is an editing user interface that represents edits and clips on a horizontal ruler.

Time progresses from left to right.
Track A separate layer on the timeline, which can hold clips. A timeline is made up of many

tracks, stacked vertically.
Clip A trimmed portion of video, audio, or both positioned on a track, and at a specific position

in time. When files are dropped on the timeline, they are represented as a Clip.
Transition A method to blend two images. Transitions can take many forms, including cuts, dissolves,

and wipes.

1.3.2 Video Tutorials

If you prefer to learn by watching videos instead of reading, we have many official video tutorials that cover a wide
range of beginner and introductory topics. These videos are a great next step on your way to master OpenShot Video
Editor!

• Video: Getting Started

• Video: The Basics (Part 1)

• Video: The Basics (Part 2)

• Video: Basic Animation

• Video: Trim, Slice, and Split

• Video: Chroma Key

• Video: Masks & Transitions

• Video: Backup & Recovery

1.3.3 Step 1 – Import Photos & Music

Before we can begin making a video, we need to import media files into OpenShot. Most video, image and music file
formats will work. Drag and drop a few videos or images and a music file from your Desktop to OpenShot. Be sure to
drop the files where the arrow in the illustration is pointing to.

1.3. Quick Tutorial 10
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Alternative methods to add files to your projects are described in the section Import Files. The “Show All”, “Video”,
“Audio”, “Image” filters above the added files allows you to only see the file types you are interested in.

1.3.4 Step 2 – Add Photos to Timeline

Next, drag each video or photo onto a track in the timeline (as seen in the illustration). The timeline represents your
final video, so arrange your photos (i.e. clips) in whatever sequence you want them to appear in your video. If you
overlap two clips, OpenShot will automatically create a smooth fade between them (only affects the image, and not
audio), displayed by blue rounded rectangles between the clips. Remember, you can rearrange the clips as many times
as needed by simply dragging and dropping them.

You can also shorten or lengthen each clip, by clicking the left or right edge and dragging your mouse. For example, if
you want a photo to last longer than 10 seconds (the default duration), simply grab the right edge of the photo (on the
timeline), and drag it to the right (to increase the clip’s duration on the timeline).

1.3. Quick Tutorial 11
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1.3.5 Step 3 – Add Music to Timeline

To make our creation more interesting, we need to add some music. Click on the music file that you imported in step 1,
and drag it onto the timeline. If the song is too long, grab the right edge of your music clip, and resize it smaller (that
will make it end earlier). You could also insert the same file multiple times, if your music is too short.

1.3. Quick Tutorial 12
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1.3.6 Step 4 – Preview your Project

To preview what our video looks & sounds like, click the Play button under the preview window. You can also pause,
rewind, and fast-forward your video project by clicking the corresponding buttons.

1.3. Quick Tutorial 13
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1.3.7 Step 5 – Export your Video

Once you have edited your photo slide-show video, the last step is to export the project. Exporting converts your
OpenShot project into a single video output file. By using the default settings, the video works on most media players
(such as VLC) or websites (such as YouTube, Vimeo, . . . ).

Click on the Export Video icon at the top of the screen (or use the File→Export Video menu). The default values will
work fine, so just click the Export Video button to render your new video.

1.3. Quick Tutorial 14
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1.3.8 Conclusion

You should now have a basic understanding of how OpenShot works. Importing, Arranging, Previewing, and Exporting.
Hopefully this tutorial took less than 5 minutes for you to complete. Please read the rest of this guide for a more detailed
understanding of OpenShot and its advanced features.

If you have any questions after reading this User Guide, please consider joining our Reddit User Community to discuss
topics, ask questions, and meet with other OpenShot users.

1.4 Video Editing Basics

You do not need to be a trained videographer to understand how to create videos well. Simple editing can keep your
viewers engaged longer, and add a professional feel, even if you are not a professional video editor.

Basically, video editing is taking footage, cutting it up, removing the pieces you do not want, and keeping the bits you
do. Back in the old days, editing was slicing reels of film and piecing it together. Thankfully software makes the whole
process much more manageable.

There are three main jobs of video editing:

1. Remove mistakes or unwanted sections

1.4. Video Editing Basics 15
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2. Keep the video moving at an engaging pace

3. Insert supporting footage, audio, or titles

Use these three points as a checklist as you edit.

1.4.1 Computer

Video editing does not require an expensive machine, especially if you are a beginner. However, it would be best if you
had a more recent monitor and graphics card. If you have an older computer, check your system specifications against
OpenShot’s System Requirements to make sure it works for video editing. Unfortunately, many older computers are not
fast enough for video editing, and you should upgrade your whole system, if possible.

1.4.2 Accessories

Before beginning a video project, ensure there is enough storage space on your computer to save all the necessary clips.
For example, one hour of 1080i video, such as from a mini-DV camcorder, takes up nearly 11 GB of storage. If your
computer’s internal storage device cannot store all the clips, the solution is to buy an external drive.

It would help if you had several cables, usually Firewire or USB, to connect your computer, external hard drive, and a
camera. Different computers and cameras accept other connectors, so check your manuals before buying anything.

1.4.3 Practical Tips

Becoming a great video editor isn’t effortless, but with practice and patience, you’ll be editing like a professional in no
time. Here are a few of the essential tips and techniques you need to know to become a skilled video editor.

Pick the Right Computer

While having a great computer won’t necessarily make you a great video editor, a faster computer will allow you to
focus more of your time on the story you’re trying to tell rather than your computer rendering. Everyone has their own
opinions about what computer is best for editing, but it all depends on your own preferences.

Keep Shooting

Record more video and audio than you think you will need for your project. Include video that enhances the scene,
sets a mood, or tells a story. You can use the extra video for smooth transitions in your project. If your project requires
voice overs or narration, we suggest using an external application to record your microphone (since OpenShot does not
include any recording capabilities yet).

Organize Your Project Files

Composition is the key to success, whether you are running Linux, on a Mac, or a Windows machine. Be sure to label
video files, audio files, and even still images clearly and keep all your clips on the same device and in the same folder
for easy access. OpenShot tries to keep up with your clips, but if you move them after your project is saved, you could
lose your entire project. Organizing before you begin editing can be very advantageous.

1.4. Video Editing Basics 16
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Watch Everything

Watching everything is the first step in the editing process. Writer and filmmaker David Andrew Stoler says there is
gold in the most unlikely of places: “Some of the most beautiful expressions you’re going to get from the actors are
after the cut.”

Edit for a Story

Remember that as you edit, you are telling a story. Editing is so much more than merely cutting footage and adding
effects. It is an opportunity to take your audience on a journey. Whether you are editing a complex narrative film or
only putting together a personal video, you tell a more in-depth story.

Keyboard Shortcuts

One of the easiest ways to tell the difference between and professional video editor and a novice is to simply look at
how much they use the keyboard. Editors that have been in the business for some time know that a few seconds saved
add up over the length of the project.

Learn the Lingo

Video editing is not just a hobby or a profession; it is an industry. And just like any industry, there is a ton of jargon to
learn. Practically speaking, you do not need to know all the terms on the Glossary to become a better video editor, but
a fundamental knowledge of the terms may help you communicate better with other video editors or clients.

Assemble, Then Make a Rough Cut

Drag and drop all your video footage into a timeline and make sure your frame size and frame rates are consistent.
Begin a new timeline and drag-and-drop the best clips into what becomes your assembly cut. Remember to save your
work frequently, and notate the date and time of each version.

Refine Your Video

In this phase, your rough cut begins to resemble a cohesive project. Adjust the sound and color, make sure the dialog is
audible, and add music, titles, or graphics in this phase. Color correction is the process of setting your footage to a color
baseline. No matter how great your subject looks on set, you will almost always need to do some basic post-processing
for a consistent video.

Refine Some More

A slow scene can set the mood and add tension or it can bore an audience. A fast scene can add adrenaline to your
audience’s systems or it can give them headaches. Some editors cut their projects several different ways before they
find the right pace. Do not let cutting your project several times discourage you.

1.4. Video Editing Basics 17
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1.4.4 Exporting

People view most of their projects on phones, tablets, or computers, so it is essential to know how to export for the
web. The goal when exporting a video for the web is to create the highest quality possible with the smallest file size.
Four main factors determine the file size of your finished video:

Codec

A codec determines the type of file format (MP4, AVI, MOV). The more compression performed by the codec, the
smaller your video’s size. Videos that are smaller in file size tend to be lower in visual quality.

Resolution

Resolution refers to the number of horizontal and vertical pixels (dots on display) your video contains. For example,
a 4K UHD (2160P) video has four times the resolution of FHD (1080P) video. A higher resolution means more
information to store so that you will have larger file sizes.

Bit Rate

The Bit Rate is the measure of the speed of data processing of your video. A higher bit rate means higher-quality video
and larger files. OpenShot allows you to manually set the Bit Rate / Quality in the Advanced tab of the Export Video
window.

Frame Rate

The frequency (in Hz) at which consecutive images, called frames, appear on the display is the Frame Rate. Typically,
you export your video in the film standard (24fps) or the TV broadcast standard of 30fps (or 25fps in PAL). While there
is not much wiggle room here, you should note that if you decide to export your video in 48fps, 50fps, or 60fps, your
file size doubles.

1.4.5 Conclusion

In conclusion, video editing is an accessible skill that can elevate your video content even if you’re not a professional
videographer. With the ability to trim, arrange, and enhance footage, you can create engaging videos that captivate
your audience. Whether you’re a beginner or on your way to becoming a skilled video editor, remember to focus on
storytelling, efficient organization, and refining your project’s details. From selecting the right computer to mastering
keyboard shortcuts and understanding technical aspects like codecs and resolutions, your journey in video editing can
lead to polished and impactful results. As you venture into the world of video editing, keep in mind that practice,
patience, and a commitment to learning are key to achieving excellence in this creative endeavor.

1.4. Video Editing Basics 18
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1.5 Main Window

OpenShot Video Editor has one main window which contains most of the information, buttons, and menus needed to
edit your video project.

1.5.1 Overview

1.5. Main Window 19
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# Name Description
1 Main Toolbar Contains buttons to open, save, and export your video project.
2 Function Tabs Switch between Project Files, Transitions, Effects, and Emojis.
3 Project Files All audio, video, and image files that have been imported into your project.
4 Preview Window This is the area that the video will playback on the screen.
5 Edit Toolbar This toolbar contains buttons used for snapping, inserting markers, slicing razor,

and jumping between markers.
6 Zoom Slider This slider will adjust the time-scale of your timeline. Drag the left or right edge

to zoom in or out. Drag the blue area to scroll the timeline left or right. Clips and
transitions are displayed as simple rectangles, to give you context for adjusting the
zoom to specific clips.

7 Play-head / Ruler The ruler shows the time-scale, and the red line is the play-head. The play-head rep-
resents the current playback position. Hold Shift key while dragging the playhead
to snap to nearby clips.

8 Timeline The timeline visualizes your video project, and each clip and transition in your
project. You can drag the mouse to select, move, or delete multiple items.

9 Filter Filter the list of items shown (project files, transitions, effects, and emojis) by using
these buttons and filter textbox. Enter a few letters of what you are looking for, and
the results will be shown.

10 Playback Left to Right: Jump to Start, Rewind, Play/Pause, Fast Forward, and Jump to End

For step-by-step instructions on the basic usage of OpenShot, be sure to read the Quick Tutorial.

1.5.2 Built-in Tutorial

When you first launch OpenShot, you will be presented with a friendly built-in tutorial. It will demonstrate and explain
the basics. Clicking Next will jump to the next topic. You can always view this tutorial again from the Help→Tutorial
menu.

1.5. Main Window 20
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1.5.3 Tracks & Layers

OpenShot uses tracks to layer videos and images. The top most track is the top layer, and the bottom track is the
bottom layer. If you are familiar with layers in a photo editing application, then you should be quite familiar with this
concept. OpenShot will stack the layers and mix each one together, just like a photo editing application. You can have
an unlimited number of tracks, but typically a simple video project will not need more than 5 tracks.

For example, imagine a 3 track video project

1.5. Main Window 21
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# Name Description
1 Top Track Clips on this track will always be on top and visible. Often watermarks and titles are

placed on higher tracks.
2 Middle Track Clips in the middle (might or might not be visible, depending on what is above them)
3 Bottom Track Clips on this track will always be on the bottom. Often audio clips are placed on lower

tracks.

1.5.4 Keyboard Shortcuts

Here is a list of the default keyboard shortcuts supported by OpenShot. You can configure these shortcuts in the
Preferences window, which is opened by selecting Edit→Preferences from the OpenShot menu bar. (On macOS,
choose OpenShot Video Editor→Preferences.) Learning a few of these shortcuts can save you a bunch of time!

Shortcut Action
Ctrl+H About OpenShot
Ctrl+M Add Marker
Ctrl+Shift+T Add Track
Ctrl+W Add to Timeline
Ctrl+B Animated Title
Ctrl+Up Center on Playhead

continues on next page

1.5. Main Window 22
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Table 1 – continued from previous page
Shortcut Action
Ctrl+P Choose Profile
Ctrl+Shift+ESC Clear All Cache
Ctrl+C Copy
Delete Delete Item
Backspace Delete Item (Alternate 1)
Ctrl+D Details View
Ctrl+Shift+C Duplicate Title
Not Set Edit Title
Ctrl+E Export Video
L Fast Forward
F11 Fullscreen
Ctrl+F Import Files. . .
Ctrl+Shift+E Insert Keyframe
Ctrl+End Jump To End
Ctrl+Home Jump To Start
Ctrl+N New Project
Right Next Frame
Ctrl+Right Next Marker
Shift+Left Nudge left
Shift+Right Nudge right
Ctrl+O Open Project. . .
Ctrl+V Paste
Space Play/Pause Toggle
Up Play/Pause Toggle (Alternate 1)
Down Play/Pause Toggle (Alternate 2)
K Play/Pause Toggle (Alternate 3)
Ctrl+Shift+P Preferences
Left Previous Frame
Ctrl+Left Previous Marker
Ctrl+I Properties
Ctrl+Q Quit
Ctrl+Y Redo
J Rewind
Not Set Save Current Frame
Ctrl+S Save Project
Ctrl+Shift+S Save Project As. . .
Ctrl+A Select All
Ctrl+Shift+A Select None
Ctrl+K Slice All: Keep Both Sides
Ctrl+L Slice All: Keep Left Side
Ctrl+J Slice All: Keep Right Side
s Slice Selected: Keep Both Sides
d Slice Selected: Keep Left Side
a Slice Selected: Keep Right Side
Ctrl+G Snapping Enabled
Ctrl+X Split Clip. . .
Ctrl+Shift+D Thumbnail View
Ctrl+T Title
R Toggle Razor

continues on next page
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Table 1 – continued from previous page
Shortcut Action
Ctrl+R Transform
Ctrl+Z Undo
= Zoom In
- Zoom Out
Ctrl+Middle Button Scroll Timeline

1.5.5 Menu

The following menu options are available on the main window on OpenShot. Most of these options can be accessed
by the keyboard shortcuts mentioned above. On some Operating Systems (such as macOS) a few of these options are
renamed and/or rearranged.

Menu
Name

Description

File New Project, Open Project, Recent Projects, Save Project, Import Files, Choose Profile, Import,
Export, Quit

Edit Undo, Redo, Clear, Preferences
Title Title, Animated Title
View Toolbar, Fullscreen, Views (Simple, Advanced, Freeze, Show All), Docks
Help Contents, Tutorial, Report a Bug, Ask a Question, Translate, Donate, About

1.5.6 Views

The OpenShot main window is composed of multiple docks. These docks are arranged and snapped together into a
grouping that we call a View. OpenShot comes with two primary views: Simple View and Advanced View.

Simple View

This is the default view, and is designed to be easy-to-use, especially for first-time users. It contains Project Files on
the top left, Preview Window on the top right, and Timeline on the bottom. If you accidentally close or move a dock,
you can quickly reset all the docks back to their default location using the View->Views->Simple View menu at the top
of the screen.

Advanced View

This is an advanced view, which adds more docks to the screen at once, improving access to many features that are
not visible in Simple View. Once you have mastered the Simple View, we recommend giving this view a try as well.
NOTE: You can also drag and drop the docks anywhere you would like, for a fully custom view.
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Docks

Each widget on the OpenShot main window is contained in a dock. These docks can be dragged and snapped around
the main window, and even grouped together (into tabs). OpenShot will always save your main window dock layout
when you exit the program. Re-launching OpenShot will restore your custom dock layout automatically.

If you have accidentally closed or moved a dock and can no longer find it, there are a couple easy solutions. First, you
can use the View->Views->Simple View menu option at the top of the screen, to restore the view back to its default. Or
you can use the View->Views->Docks->. . . menu to show or hide specific dock widgets on the main window.

1.6 Files

To create a video, we need to make media files available to our project by importing files into OpenShot. Most media
file types are recognized, such as videos, images, and audio files. Files can be viewed and managed in the Project Files
panel.

Note that imported files are not copied anywhere, they remain in the physical location they were before and are simply
being made available to your video project. So, they must not be deleted, renamed, or moved after adding them to your
project. The “Show All”, “Video”, “Audio”, “Image” filters above the files allows you to only see the file types you are
interested in. You can also toggle the view between details and thumbnails view of your files.

1.6.1 Import Files

These are all possible methods to import media files into OpenShot:

Import File Method Description
Drag and Drop Drag and drop the files from your file manager (file explorer, finder, etc. . . ).
Context menu (File
Menu)

Right click anywhere in the Project Files panel and choose Import Files.

Main Menu In the main menu choose: File→Import Files.
Toolbar button Click the + toolbar button in the main toolbar.
Keyboard shortcut Press Ctrl-F (Cmd-F on Mac).
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1.6.2 File Menu

To view the file menu, right click on a file (in the Project Files panel). Here are the actions you can use from the file
menu.
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File Context Option Description
Import Files. . . Import files into your project
Thumbnail/Detail Toggle the view between details and thumbnails
Preview File Preview a media file
Split Clip. . . Split a file into many smaller clips
Edit Title Edit an existing title SVG file
Duplicate Title Make a copy, and then edit the copied title SVG file
Add to Timeline Add many files to the timeline in one step
File Properties View the properties of a file, such as frame rate, size, etc. . .
Remove from Project Remove a file from the project

1.6.3 Split Clip

If you need to cut a file into many smaller clips before editing, the Split Clip dialog is built exactly for this purpose.
Right click on a file, and choose Split Clip. . . from the file menu. This opens the Split Clip dialog. Use this dialog to
quickly cut out as many small clips as you need. The dialog stays open after you create a clip, to allow you to repeat
the steps for your next clip. When you are finished, simply close the dialog.
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# Name Description
1 Start of Clip Choose the starting frame of your clip by clicking this button
2 End of Clip Choose the ending frame of your clip by clicking this button
3 Name of Clip Enter an optional name
4 Create Clip Create the clip (which resets this dialog, so you can repeat these steps for each clip)

Please refer to the section Trimming & Slicing for more ways to cut and slice clips directly in the timeline.

1.6.4 Export Clips

If you want your clips available outside of your OpenShot project, or want to copy all your video assets to one place,
you can do this with the Export Clips dialog. Simply Ctrl+Click to select any clips or files you like, then Right
Click and choose Export Clips. In the dialog that appears, choose a destination folder, and click Export.

NOTE: This will export each clip using its original video profile (width, height, framerate, aspect ratio, etc. . . ). It also
supports any Split Clip (described above). For example, if you have split a long video file into many different clips (and
named them), you can now export all the clips as separate video files (using the original clip’s video profile).
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1.6.5 Add to Timeline

In certain cases, you might need to add many files to the timeline at the same time. For example, a photo slideshow, or
a large number of short video clips. The Add to Timeline dialog can automate this task for you. First, select all files
you need to add, right click, and choose Add to Timeline.
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# Name Description
1 Selected Files The list of selected files that need to be added to the timeline
2 Order of Files Use these buttons to reorder the list of files (move up, move down, randomize,

remove)
3 Timeline Position Choose the starting position and track where these files need to be inserted on the

timeline
4 Fade Options Fade in, fade out, both, or none (only affects the image, and not audio)
5 Zoom Options Zoom in, zoom out, or none
6 Transitions Choose a specific transition to use between files, random, or none (only affects

the image, and not the audio)

1.6.6 Properties

To view the properties of any imported file in your video project, right click on the file, and choose File Properties.
This will launch the file properties dialog, which displays information about your media file. For certain types of images
(i.e. image sequences), you can adjust the frame rate on this dialog also.

# Name Description
1 File Properties Select an image sequence in the Project Files panel, right click and choose

File Properties
2 Frame Rate For image sequences, you can also adjust the frame rate of the animation
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1.6.7 Remove from Project

This will remove a file from the project. It will not delete the underlying physical file though, so removing a file from
the project merely makes it unavailable for this video project.

1.6.8 Missing Files

When you create and save a project in OpenShot, any files imported into the software (such as videos, audio, and
images) must remain accessible throughout the project’s duration. This means that these imported files should not be
renamed, deleted, or moved to different folders. Additionally, the full path where these files are located should not be
renamed either. This principle applies to other video editing software as well.

For example, users might move or delete folders, unplug their USB devices, or move or delete their project files. Any
of these examples cause a Missing File message, in which OpenShot prompts you to locate the folder of the missing
file(s). Depending on the number of files you added to your project, OpenShot could prompt you many times to find
the missing files.

When OpenShot saves a project, all file paths are converted to relative file paths. As long as you keep all assets
organized in the same parent folder (including the *.osp project file), you will be able to move your project folder
without triggering any missing file(s) prompts. You can even move a self-contained project folder to another computer
without any issues.

Everyone has their unique way of organizing files, and it’s crucial to remember not to make changes to file paths,
rename files, or delete files when working with video editors, as it can lead to missing file issues. For a detailed guide
on missing file(s), see The Case of “Missing Files”!

1.7 Clips

In OpenShot, when you add project files (videos, images, and audio) to the timeline, they appear as clips represented
by rounded rectangles. These clips come with different properties that influence how they’re rendered and composited.
These properties include the clip’s position, layer, scale, location, rotation, and alpha.

You can examine a clip’s properties by either right-clicking and selecting Properties or by double-clicking the clip.
The properties are listed alphabetically in the Property dock, and you can use the filter options at the top to find specific
properties. See Clip Properties for a list of all clip properties.

To make adjustments to a property:

• For rough changes, you can drag the slider.

• For precise adjustments, double-click the property to enter exact values.

• If the property involves non-numerical choices, right-click or double-click for options.

Clip properties play a vital role in the Animation system. Whenever you modify a clip property, a key-frame is
automatically created at the current playhead position. If you want a property change to apply throughout the entire
clip, ensure the playhead is positioned at or before the clip’s start, before making adjustments. You can easily find a
clip’s start by using the next/previous marker feature on the Timeline toolbar.
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# Name Description
1 Clip 1 A video clip
2 Transition A gradual fade transition between the 2 clip images (does not affect the audio)
3 Clip 2 An image clip

1.7.1 Trimming & Slicing

OpenShot has many easy ways to adjust the start and end trim positions of a clip (also known as trimming). The most
common method is simply clicking and dragging the left (or right) edge of the clip. Trimming a clip can be used to
remove unwanted sections from the beginning and/or ending of a clip.

To slice a clip into smaller sections, OpenShot provides many different options, including dividing/slicing a clip at
the play-head (i.e. vertical red playback line) position. Trimming and Slicing clips are two very powerful tools when
editing a video project, allowing the user to quickly rearrange sections of video and remove unwanted sections.

Here is a list of all methods for cutting and/or trimming clips in OpenShot:
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Trim & Slice Method Description
Resizing Edge Mouse over the edge of a clip, and resize the edge, by dragging it left/right.
Slice When the play-head (i.e. vertical red playback line) is overlapping a clip, right click

on the clip, and choose Slice.
Slice All When the play-head is overlapping many clips, right click on the play-head, and

choose Slice All (all intersecting clips on all tracks will be cut/sliced).
Split Clip Dialog Right click on a file, and choose Split Clip. A dialog will appear which allows for

creating lots of small cuts in a single video file.
Razor Tool The razor tool from the Edit Toolbar cuts a clip wherever you click on it. So be

careful, it is easy and dangerous!

Keep in mind that the above cutting methods also have Keyboard Shortcuts, to save even more time.

1.7.2 Context Menu

OpenShot has tons of great preset animations and clip properties, such as fading, sliding, zooming, reversing time,
adjusting volume, etc. . . These presets can be accessed by right-clicking on a clip, revealing the context menu. A
preset sets one (or more) clip properties for the user without needing to manually set the key-frame clip properties. See
Clip Properties.

Some presets allow the user to target either the start, end, or entire clip, and most presets allow the user to reset a
specific clip property. For example, when using the Volume preset, the user has the following menu options:

• Reset - This will reset the volume to the original level.

• Start of Clip - Your volume level selection will apply at the Beginning of the clip.

• End of Clip - Your volume level selection will apply to the End of the clip.

• Entire Clip - Your volume level selection will apply to the Entire clip.

1.7. Clips 33



OpenShot Video Editor Documentation, Release 3.1.1

Preset Name Description
Fade Fade the image in or out (often easier than using a transition)
Animate Zoom and slide a clip
Rotate Rotate or flip a clip
Layout Make a video smaller or larger, and snap to any corner
Time Reverse and speed up or slow down video
Volume Fade in or out the volume, reduce or increase the volume of a clip, or mute
Separate Audio Separate the audio from a clip. This preset can either create a single detached audio clip

(positioned on a layer below the original clip), or multiple detached audio clips (one per
audio track, positioned on multiple layers below the original clip)

Slice Cut the clip at the play-head position
Transform Enable transform mode
Display Show waveform or thumbnail for a clip
Properties Show the properties panel for a clip
Copy / Paste Copy and paste key frames or duplicate an entire clip (with all key frames)
Remove Clip Remove a clip from the timeline

Fade

The Fade preset enables smooth transitions by gradually increasing or decreasing the clip’s opacity. It creates a fade-in
or fade-out of the clip image, ideal for introducing or concluding clips. See Alpha key-frame.

• Usage Example: Applying a fade-out to a video clip to gently conclude a scene.

• Tip: Adjust the duration of the fade effect (slow or fast) to control its timing and intensity.

Animate

The Animate preset adds dynamic motion to clips, combining zooming and sliding animations. It animates a clip by
zooming in or out while sliding across the screen. It can slide in many specific directions, or slide and zoom to a
random location. See Location X and Location Y and Scale X and Scale Y key-frames.

• Usage Example: Using the animate preset to simulate a camera movement across a landscape shot.

• Tip: Experiment with different animation speeds and directions for diverse visual effects.

Rotate

The Rotate preset introduces easy rotation and flipping of clips, enhancing their visual appeal. It enables orientation
adjustment, by rotating and flipping a clip for creative visual transformations. See Rotation key-frame.

• Usage Example: Rotating a photo or video by 90 degree (a portrait video to a landscape)

• Usage Example: If your video is oriented sideways (90 degrees), you can rotate it clockwise or counterclockwise
by 90 degrees to bring it to the correct orientation. This can be useful when you accidentally recorded a video
in portrait mode when you intended it to be landscape.

• Usage Example: If your video is upside down, you can rotate it by 180 degrees to flip it to the correct orientation.
This can happen if you accidentally held your camera the wrong way while recording.

1.7. Clips 34



OpenShot Video Editor Documentation, Release 3.1.1

Layout

The Layout preset adjusts the size of a clip and snaps it to a chosen corner of the screen. It resizes a clip and anchors it
to a corner or the center, useful for picture-in-picture or watermark effects. See Location X and Location Y and Scale
X and Scale Y key-frames.

• Usage Example: Placing a logo in the corner of a video using the layout preset.

• Tip: Combine with animation presets for dynamic transitions involving resizing and repositioning.

Time

The Time preset manipulates clip playback speed, allowing for reverse playback or time-lapse effects. It alters the speed
and direction of a clip’s playback, enhancing visual storytelling. See Time key-frame.

• Usage Example: Creating a slow-motion effect to emphasize a specific action.

• Tip: Use time presets to creatively manipulate the pacing of your video.

Volume

The Volume preset controls audio properties, facilitating smooth volume adjustments. It manages audio volume, in-
cluding fading in/out, reducing/increasing volume, or muting. See Volume key-frame.

• Usage Example: Applying a gradual volume fade-out to transition between scenes.

• Tip: Utilize volume presets for quickly lowering or raising volume levels.

Separate Audio

The Separate Audio preset splits the audio from a clip, creating detached audio clips positioned below the original clip
on the timeline. This preset can either create a single detached audio clip (positioned on a layer below the original clip)
or multiple detached audio clips (one per audio track, positioned on multiple layers below the original clip).

• Usage Example: Extracting background music from a video clip for independent control.

• Tip: Use this preset to fine-tune audio elements separately from the visual content.

Slice

The Slice preset cuts a clip at the play-head position, creating two separate clips. It divides a clip into two distinct parts
at the current play-head position. See Trimming & Slicing.

• Usage Example: Splitting a clip to remove an unwanted section.

• Tip: Quickly cut a clip into many smaller clips, for easy rearranging.
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Transform

The Transform preset activates the transform tool for a clip, allowing for quick adjustments to location, scale, rotation,
shear, and rotation origin point.

To quickly adjust the location, scale, rotation, and shear of a clip, select a clip on the timeline to activate the transform
tool. By default, the selected clip appears in the preview window with transform controls (blue lines and squares). Or
if the transform tool is disabled, right click on a clip and choose Transform.

• Dragging the blue squares will adjust the scale of the image.

• Dragging the center will move the location of the image.

• Dragging the mouse on the outside of the blue lines will rotate the image.

• Dragging along the blue lines will shear the image in that direction.

• Dragging the circle in the middle will move the origin point that controls the center of rotation.

Note: Pay close attention to the play-head position (red playback line). Key frames are automatically created at the
current playback position, to help quickly create animations. If you want to transform a clip with no animation, be
sure the playhead is positioned before (to the left) of your clip. You can also manually adjust these same clip properties
in the property editor, see Clip Properties.

• Usage Example: Using transform mode to resize and reposition a clip for a picture-in-picture effect.

• Tip: Utilize this preset to precisely control a clip’s appearance.

• Tip: To crop a clip in OpenShot, you must use the Crop effect. Cropping is not a feature of the transform tool.
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Display

The Display preset toggles the display mode of a clip on the timeline, showing either its waveform or thumbnail.

• Usage Example: Displaying the audio waveform for precise audio editing.

• Tip: Use this preset to focus on specific aspects of a clip’s audio during editing.

Properties

The Properties preset opens the properties panel for a clip, allowing quick access for adjustments to clip properties,
such as location, scale, rotation, etc. . . See Clip Properties.

• Usage Example: Adjusting clip properties like opacity, volume, or position.

• Tip: Apply this preset to streamline adjustments to all clip properties in a single dock.

Copy / Paste

The Copy / Paste preset facilitates copying and pasting keyframes or duplicating an entire clip along with its keyframes.

• Usage Example: Duplicating a clip with intricate animations for reuse in different parts of the project.

• Tip: Use this preset to replicate animations or effects across multiple clips.

Remove Clip

The Remove Clip preset deletes a clip and its associated elements from the timeline.

• Usage Example: Deleting unused or redundant clips to declutter the project.

• Tip: Be cautious when using this preset, as it permanently removes clips from the timeline.

1.7.3 Effects

In addition to the many clip properties which can be animated and adjusted, you can also drop an effect directly onto
a clip from the effects dock. Each effect is represented by a small colored letter icon. Clicking the effect icon will
populate the properties of that effect, and allow you to edit (and animate) them. For the full list of effects, see Effects.
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1.7.4 Clip Properties

Below is a list of clip properties which can be edited, and in most cases, animated over time. To view a clip’s properties,
right click and choose Properties. The property editor will appear, where you can change these properties. Note: Pay
close attention to where the play-head (i.e. red playback line) is. Key frames are automatically created at the current
playback position, to help quickly create animations.

When animating clip properties, you can fade a clip from opaque to transparent with alpha, slide a clip around the
screen with location_x and location_y, scale a clip smaller or larger with the scale_x and scale_y, fade the
volume of a clip quieter or louder with volume, and much more. If you want to set a single, static clip property with
no animation, be sure the playhead is positioned before (to the left) of your clip when adjusting the property value.

See the table below for a full list of clip properties.
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Clip Property
Name

Type Description

Alpha Key-Frame Curve representing the alpha for fading the image and adding transparency
(1 to 0)

Channel Filter Key-Frame A number representing an audio channel to filter (clears all other channels)
Channel Map-
ping

Key-Frame A number representing an audio channel to output (only works when filter-
ing a channel)

Frame Number Enum The format to display the frame number (if any)
Duration Float The length of the clip (in seconds). Read-only property. This is calculated

by: End - Start.
End Float The end trimming position of the clip (in seconds)
Gravity Enum The gravity of a clip determines where it snaps to its parent (details below)
Enable Audio Enum An optional override to determine if this clip has audio (-1=undefined,

0=no, 1=yes)
Enable Video Enum An optional override to determine if this clip has video (-1=undefined,

0=no, 1=yes)
ID String A randomly generated GUID (globally unique identifier) assigned to each

clip. Read-only property.
Track Int The layer which holds the clip (higher tracks are rendered on top of lower

tracks)
Location X Key-Frame Curve representing the relative X position in percent based on the gravity

(-1 to 1)
Location Y Key-Frame Curve representing the relative Y position in percent based on the gravity

(-1 to 1)
Volume Mixing Enum The volume mixing choices control how volume is adjusted before mixing

(None=don’t adjust volume of this clip, Reduce=lower the volume to 80%,
Average=divide volume based on # of concurrent clips, details below)

Origin X Key-Frame Curve representing the rotation origin point, X position in percent (-1 to 1)
Origin Y Key-Frame Curve representing the rotation origin point, Y position in percent (-1 to 1)
Parent String The parent object to this clip, which makes many of these keyframe values

initialize to the parent value
Position Float The position of the clip on the timeline (in seconds, 0.0 is the beginning of

the timeline)
Rotation Key-Frame Curve representing the rotation (0 to 360)
Scale Enum The scale determines how a clip should be resized to fit its parent (details

below)
Scale X Key-Frame Curve representing the horizontal scaling in percent (0 to 1)
Scale Y Key-Frame Curve representing the vertical scaling in percent (0 to 1)
Shear X Key-Frame Curve representing X shear angle in degrees (-45.0=left, 45.0=right)
Shear Y Key-Frame Curve representing Y shear angle in degrees (-45.0=down, 45.0=up)
Start Float The start trimming position of the clip (in seconds)
Time Key-Frame Curve representing the frames over time to play (used for speed and direc-

tion of video)
Volume Key-Frame Curve representing the volume for fading audio quieter/louder, mute, or

adjusting levels (0 to 1)
Wave Color Key-Frame Curve representing the color of the audio waveform
Waveform Bool Should a waveform be used instead of the clip’s image
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Alpha

The Alpha property is a key-frame curve that represents the alpha value, determining fading and transparency of the
image in the clip. The curve ranges from 1 (fully opaque) to 0 (completely transparent).

• Usage Example: Applying a gradual fade-in or fade-out effect to smoothly transition clips.

• Tip: Use keyframes to create complex fading patterns, such as fading in and then fading out for a ghostly effect.

Channel Filter

The Channel Filter property is a key-frame curve used for audio manipulation. It specifies a single audio channel to
be filtered while clearing all other channels.

• Usage Example: Isolating and enhancing specific audio elements, like isolating vocals from a song.

• Tip: Combine with the “Channel Mapping” property to route the filtered channel to a specific audio output.

Channel Mapping

The Channel Mapping property is a key-frame curve that defines the output audio channel for the clip. This property
works in conjunction with the “Channel Filter” property and specifies which channel is retained in the output.

• Usage Example: Keeping the filtered channel’s audio while discarding others for an unconventional audio mix.

• Tip: Experiment with mapping different channels to create unique audio effects, like panning sounds between
speakers.

Frame Number

The Frame Number property specifies the format in which the frame numbers are displayed within the clip, if applicable.

• Usage Example: Displaying frame numbers in the top left corner of the clip, as either absolute frame number
or relative to the start of the clip.

• Tip: This can help with identifying precise frame numbers or troubleshooting a problem.

Duration

The Duration property is a float value indicating the length of the clip in seconds. This is a Read-only property. This
is calculated by: End - Start. To modify duration, you must edit the Start and/or End clip properties.

• Usage Example: Inspect the duration of a clip to ensure it fits a specific time slot in the project.

• Tip: Consider using the “Duration” property for clips that need to match specific time intervals, such as dialogue
or scenes.
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End

The End property defines the trimming point at the end of the clip in seconds, allowing you to control how much of
the clip is visible in the timeline. Changing this property will impact the Duration clip property.

• Usage Example: Trimming the end of a clip to align with another clip or trimming off unwanted sections of the
clip.

• Tip: Combine the “Start” and “End” properties to precisely control the visible portion of the clip.

Gravity

The Gravity clip property sets the initial display position coordinate (X,Y) for the clip, after it has been scaled (see
Scale). This affects where the clip picture is initially displayed on the screen, for example Top Left or Bottom Right.
The default gravity option is Center, which displays the picture in the very center of the screen. The gravity options
are:

• Top Left – The top and left edges of the clip align with the top and left edges of the screen

• Top Center – The top edge of the clip aligns with the top edge of the screen; the clip is horizontally centered on
the screen.

• Top Right – The top and right edges of the clip align with the top and right edges of the screen

• Left – The left edge of the clip aligns with the left edge of the screen; the clip is vertically centered on the screen.

• Center (default) – The clip is centered horizontally and vertically on the screen.

• Right – The right edge of the clip aligns with the right edge of the screen; the clip is vertically centered on the
screen.

• Bottom Left – The bottom and left edges of the clip align with the bottom and left edges of the screen

• Bottom Center – The bottom edge of the clip aligns with the bottom edge of the screen; the clip is horizontally
centered on the screen.

• Bottom Right – The bottom and right edges of the clip align with the bottom and right edges of the screen

Enable Audio

The Enable Audio property is an enumeration that overrides the default audio setting for the clip. Possible values: -1
(undefined), 0 (no audio), 1 (audio enabled).

• Usage Example: Turning off unwanted audio for a clip, like ambient noise.

• Tip: Use this property to control audio playback for specific clips, especially clips which have no useful audio
track.

Enable Video

The Enable Video property is an enumeration that overrides the default video setting for the clip. Possible values: -1
(undefined), 0 (no video), 1 (video enabled).

• Usage Example: Disabling the video of a clip while retaining its audio for creating audio-only sequences.

• Tip: This property can be helpful when creating scenes with audio commentary or voiceovers.
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ID

The ID property holds a randomly generated GUID (Globally Unique Identifier) assigned to each clip, ensuring its
uniqueness. This is a Read-only property, and assigned by OpenShot when a clip is created.

• Usage Example: Referencing specific clips within custom scripts or automation tasks.

• Tip: While typically managed behind the scenes, understanding clip IDs can aid in advanced project customiza-
tion.

Track

The Track property is an integer indicating the layer on which the clip is placed. Clips on higher tracks are rendered
above those on lower tracks.

• Usage Example: Arranging clips in different layers for creating visual depth and complexity.

• Tip: Use higher tracks for elements that need to appear above others, like text overlays or graphics.

Location X and Location Y

The Location X and Location Y properties are key-frame curves that determine the relative position of the clip, ex-
pressed in percentages, based on the specified gravity. The range for these curves is -1 to 1. See Transform.

• Usage Example: Animating a clip’s movement across the screen using key-frame curves for both X and Y
locations.

• Tip: Combine with gravity settings to create dynamic animations that adhere to consistent alignment rules.

Volume Mixing

The Volume Mixing property is an enumeration that controls how volume adjustments are applied before mixing audio.
Options: None (no adjustment), Reduce (volume lowered to 80%), Average (volume divided based on the number of
concurrent clips).

• Usage Example: Automatically lowering the volume of a clip to allow background music to stand out more
prominently.

• Tip: Experiment with volume mixing options to achieve balanced audio levels across different clips.

Mixing audio involves adjusting volume levels so that overlapping clips do not become too loud (creating audio dis-
tortion and loss of audio clarity). If you combine particularly loud audio clips on multiple tracks, clipping (a staccato
audio distortion) may occur. To avoid distortion, OpenShot might need to reduce the volume levels in overlapping clips.
The following audio mixing methods are available:

• None - Make no adjustments to volume data before mixing audio. Overlapping clips will combine audio at full
volume, with no reduction.

• Average - Automatically divide the volume of each clip based on the # of overlapping clips. For example, 2
overlapping clips would each have 50% volume, 3 overlapping clips would each have 33% volume, etc. . .

• Reduce - Automatically reduce overlapping clips volume by 20%, which reduces the likelihood of becoming too
loud, but does not always prevent audio distortion. For example, if you have 10 loud clips overlapping, each with
a 20% reduction in volume, it might still exceed the max allowable volume and exhibit audio distortion.

For quickly adjusting the volume of a clip, you can use the simple Volume Preset menu. See Context Menu. For precise
control over the volume of a clip, you can manually set the Volume Key-frame. See Volume.
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Origin X and Origin Y

The Origin X and Origin Y properties are key-frame curves that define the rotation origin point’s position in percentages.
The range for these curves is -1 to 1. See Transform.

• Usage Example: Rotating a clip around a specific point, such as a character’s pivot joint.

• Tip: Set the origin point to achieve controlled and natural-looking rotations during animations.

Clip Parent

The Parent property of a clip sets the initial keyframe values to the parent object. For example, if many clips all point
to the same parent clip, they will inherit all their default properties, such as location_x, location_y, scale_x,
scale_y, etc. . . This can be very useful in certain circumstances, such as when you have many clips that need to move
or scale together.

• Usage Example: Creating complex animations by establishing a parent-child relationship between clips.

• Tip: Utilize this property to propagate changes from the parent clip to child clips for consistent animations.

• Tip: You can also set the parent attribute to a Tracker or Object Detector effect, so the clip follows the
location and scale of a tracked object. Also see Effect Parent.

Position

The Position property determines the clip’s position on the timeline in seconds, with 0.0 indicating the beginning.

• Usage Example: Timing a clip’s appearance to coincide with specific events in the project.

• Tip: Adjust the position to synchronize clips with audio cues or visual elements.

Rotation

The Rotation property is a key-frame curve that controls the rotation angle of the clip, ranging from -360 to 360 degrees.
You can rotate clockwise or counterclockwise. Quickly adjust the orientation angle of a clip (sideways, upside down,
right side up, portrait, landscape), flip a clip, or animate the rotation. See Transform.

• Usage Example: Simulating a spinning effect by animating the rotation curve.

• Tip: Use this property creatively for effects like rotating text or emulating camera movement.

• Tip: Experiment with rotating your video at different angles, not just 90 or 180 degrees. Sometimes a slight tilt
or a specific angle can add creative flair to your video, especially for artistic or storytelling purposes.

• Tip: After rotating your video, you might end up with black bars around the edges. Consider cropping and
resizing the video to eliminate these bars and maintain a clean, polished look.

• Tip: If you’re dealing with vertical videos that are meant to be watched on horizontal screens, rotate them by
90 degrees and then scale them up to fill the frame. This way, your vertical video will occupy more screen real
estate.

• Tip: If the horizon in your video appears slanted due to camera tilt, use rotation to level it. This is particularly
important for landscape shots to maintain a professional and visually pleasing appearance.
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Scale

The Scale property is the initial resizing or scaling method used to display the picture of a clip, which may be further
adjusted by the Scale X and Scale Y clip properties (see Scale X and Scale Y ). It is recommended to use assets with
the same aspect ratio as your project profile, which allows many of these resizing methods to fully scale your clip up
to the size of the screen, without adding any black bars on the edges. The scale methods are:

• Best Fit (default) – The clip is as large as possible without changing the aspect ratio. This might result in black
bars on certain sides of the picture, if the aspect ratio does not exactly match your project size.

• Crop – The aspect ratio of the clip is maintained while the clip is enlarged to fill the entire screen, even if that
means some of it will be cropped. This prevents black bars around the picture, but if the aspect ratio of the clip
does not match the project size, some of the picture will be cropped off.

• None – The clip is displayed in its original size. This is not recommended, since the picture will not scale
correctly if you change the project profile (or project size).

• Stretch – The clip is stretched to fill the entire screen, changing the aspect ratio if necessary.

Scale X and Scale Y

The Scale X and Scale Y properties are key-frame curves that represent horizontal and vertical scaling in percentages,
respectively. The range for these curves is 0 to 1. See Transform.

• Usage Example: Creating a zoom-in effect by animating the Scale X and Scale Y curves simultaneously.

• Tip: Scale the image larger than the screen, only revealing a portion of the video. This is a simple way to crop
a portion of the video.

• Tip: Scale the horizontal and vertical elements separately, to squash and stretch the image in fun ways.

• Tip: Combine scaling with rotation and location properties for dynamic transformations.

Shear X and Shear Y

The Shear X and Shear Y properties are key-frame curves that represent X and Y shear angles in degrees, respectively.
See Transform.

• Usage Example: Adding a dynamic tilt effect to a clip by animating the shear angles.

• Tip: Use shear properties for creating slanted or skewed animations.

Start

The Start property defines the trimming point at the beginning of the clip in seconds. Changing this property will
impact the Duration clip property.

• Usage Example: Removing the initial portion of a clip to focus on a specific scene or moment.

• Tip: Utilize the “Start” property in combination with the “End” property for precise clip trimming.

1.7. Clips 44



OpenShot Video Editor Documentation, Release 3.1.1

Time

The Time property is a key-frame curve that represents frames played over time, affecting the speed and direction of
the video. You can use one of the available presets (normal, fast, slow, freeze, freeze & zoom, forward, backward), by
right clicking on a Clip and choosing the Time menu. Many presets are available in this menu for reversing, speeding
up, and slowing down a video clip, see Context Menu.

Optionally, you can manually set key-frame values for the Time property. The value represents the frame number at
the position of the key-frame. This can be tricky to determine and might require a calculator to find the needed values.
For example, if the beginning of your Clip sets a time value of 300 (i.e. frame 300), and the end of your clip sets a
time value of 1 (frame 1), OpenShot will play this clip backwards, starting at frame 300 and ending at frame 1, at the
appropriate speed (based on where these key-frames are set on the timeline). NOTE: To determine the total number of
frames in a clip, multiply the duration of the file with the FPS of the project (for example: 47.0 sec clip duration
X 24.0 Project FPS = 1128 total frames).

This allows for some very complex scenarios, such as jump cutting inside a clip, reversing a portion of a clip, slowing
down a portion of a clip, freezing on a frame, and much more. See Animation for more details on manual key-frame
animations.

• Usage Example: Creating a slow-motion or time-lapse effect by modifying the time curve.

• Tip: Adjust the “Time” property to control video playback speed for dramatic visual impact.

Volume

The Volume property is a key-frame curve that controls audio volume or level, ranging from 0 (mute) to 1 (full volume).
For automatic adjustment of volume, see Volume Mixing.

• Usage Example: Gradually fading out background music as dialogue becomes more prominent, or increasing
or lowering the volume of a clip.

• Tip: Combine multiple volume key-frames for nuanced audio adjustments, such as ducking the level of the music
when dialog is spoken.

• Tip: For quickly adjusting the volume of a clip you can use the simple Volume Preset menu. See Context Menu.

Wave Color

The Wave Color property is a key-frame curve that represents the color of the audio waveform visualization.

• Usage Example: Matching the waveform color to the project’s overall visual theme.

• Tip: Experiment with different colors to enhance the visual appeal of the waveform or animate the color over
time.

Waveform

The Waveform property is a boolean that determines whether a waveform visualization is used instead of the clip’s
image.

• Usage Example: Displaying an audio waveform in place of the video for visually highlighting audio patterns.

• Tip: Use waveform visualization for emphasizing music beats or voice modulations.
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1.7.5 More Information

For more info on key frames and animation, see Animation.

1.8 Transitions

A transition is used to gradually fade (or wipe) between two clip images. In OpenShot, transitions are represented by
blue, rounded rectangles on the timeline. They are automatically created when you overlap two clips, and can be added
manually by dragging one onto the timeline from the Transitions panel. A transition must be placed on top of a clip
(overlapping it), with the most common location being the beginning or end or a clip.

NOTE: Transitions do not affect audio, so if you are intending to fade in/out the audio volume of a clip, you must
adjust the volume clip property. See Clip Properties.

1.8.1 Overview
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# Name Description
1 Clip 1 A video clip
2 Transi-

tion
A gradual fade transition between the 2 clip images, created automatically by overlapping the clips
(does not affect the audio)

3 Clip 2 An image clip

1.8.2 Direction

Transitions adjust the alpha/transparency of the overlapping clip image (i.e. the clip under the transition), and can either
fade from opaque to transparent, or transparent to opaque (does not affect the audio). Right click and choose Reverse
Transition to change the direction of the fade. You can also manually adjust the Brightness curve, animating the visual
fade in any way you wish.

1.8.3 Cutting & Slicing

OpenShot has many easy ways to adjust the start and end trim positions of a transition (otherwise known as cutting or
trimming). The most common method is simply grabbing the left (or right) edge of the transition and dragging. Here
is a list of methods for cutting transitions in OpenShot:

Slice Method Description
Slice When the play-head (i.e. red playback line) is overlapping a transition, right click on the

transition, and choose Slice
Slice All When the play-head is overlapping many transitions, right click on the play-head, and choose

Slice All (it will cut all intersecting transitions)
Resizing Edge Mouse over the edge of a transition, and resize the edge
Razor Tool The razor tool cuts a transition wherever you click, so be careful. Easy and dangerous.

Keep in mind that all of the above cutting methods also have Keyboard Shortcuts.
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1.8.4 Mask

In video editing, masks are powerful tools that allow you to selectively display specific areas of a video clip. Similar
to masking in image editing, video masks define a region where changes will be applied while leaving other parts of
the video unaffected.

A mask can be thought of as a shape or path that outlines the area you want to target. Commonly used shapes include
rectangles, circles, and freeform paths. The masked area is referred to as the “masked region.”

Masks can be animated, allowing you to change the shape or position over time. This enables dynamic effects like
revealing hidden elements or transitioning between different visual states. In OpenShot, you can convert a transition
to a mask, by customizing the Brightness key-frame curve. Keeping a static (unchanging) value of brightness, will
maintain a fixed mask location. Combine this with custom transition images, or even custom image sequences, to
create animated, complex masks.

1.8.5 Custom Transition

Any greyscale image can be used as a transition (or mask), by adding it to your ~/.openshot_qt/transitions/
folder. Just be sure to name your file something that is easily recognizable, and restart OpenShot. Your custom transi-
tion/mask will now show up in the list of transitions.

1.8.6 Transition Properties

Below is a list of transition properties which can be edited, and in most cases, animated over time. To view a transition’s
properties, right click and choose Properties. The property editor will appear, where you can change these properties.
NOTE: Pay close attention to where the play-head (i.e. red playback line) is. Key frames are automatically created at
the current playback position, to help create animations.

NOTE: Transitions do not affect audio, so if you are intending to fade in/out the audio volume of a clip, you must adjust
the volume clip property. See Clip Properties.

Transition
Property Name

Type Description

Brightness Key-frame Curve representing the brightness of the transition image, which affects the
fade/wipe (-1 to 1)

Contrast Key-frame Curve representing the contrast of the transition image, which affects the
softness/hardness of the fade/wipe (0 to 20)

Duration Float The length of the transition (in seconds). Read-only property.
End Float The end trimming position of the transition (in seconds).
ID String A randomly generated GUID (globally unique identifier) assigned to each

transition. Read-only property.
Parent String The parent object to this transition, which makes many of these keyframe

values initialize to the parent value.
Position Float The position of the transition on the timeline (in seconds).
Replace Image Bool For debugging a problem, this property displays the transition image (in-

stead of becoming a transparency).
Start Float The start trimming position of the transition (in seconds).
Track Int The layer which holds the transition (higher tracks are rendered on top of

lower tracks).
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Duration

The Duration property is a float value indicating the length of the transition in seconds. This is a Read-only property.
This is calculated by: End - Start. To modify duration, you must edit the Start and/or End transition properties.

• Usage Example: Inspect the duration of a transition to ensure it fits a specific time slot in the project.

• Tip: Consider using the “Duration” property for transitions that need to match specific time intervals, such as
dialogue or scenes.

End

The End property defines the trimming point at the end of the transition in seconds, allowing you to control how much
of the transition is visible in the timeline. Changing this property will impact the Duration transition property.

• Usage Example: Trimming the end of a transition to align with another clip or trimming off unwanted sections
of the transition.

• Tip: Combine the “Start” and “End” properties to precisely control the visible portion of the transition.

ID

The ID property holds a randomly generated GUID (Globally Unique Identifier) assigned to each transition, ensuring
its uniqueness. This is a Read-only property, and assigned by OpenShot when a transition is created.

• Usage Example: Referencing specific transitions within custom scripts or automation tasks.

• Tip: While typically managed behind the scenes, understanding transition IDs can aid in advanced project cus-
tomization.

Track

The Track property is an integer indicating the layer on which the transition is placed. Transitions on higher tracks are
rendered above those on lower tracks.

• Usage Example: Arranging transitions in different layers for creating visual depth and complexity.

• Tip: Use higher tracks for elements that need to appear above others, like text overlays or graphics.

1.9 Effects

Effects are used in OpenShot to enhance or modify the audio or video of a clip. They can modify pixels and audio
data, and can generally enhance your video projects. Each effect has its own set of properties, most of which can be
animated over time, for example varying the Brightness & Contrast of a clip over time.

Effects can be added to any clip by dragging and dropping them from the Effects tab onto a clip. Each effect is repre-
sented by a small colored icon and the first letter of the effect name. Note: Pay close attention to where the play-head (i.e.
red playback line) is. Key frames are automatically created at the current playback position, to help create animations
quickly.

To view an effect’s properties, right-click on the effect icon, revealing the context menu, and choose Properties. The
property editor will appear, where you can edit these properties. Properties appear alphabetically in the dock, with
filter options available at the top. See Clip Properties.

To adjust a property:
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• Drag the slider for coarse changes.

• Double-click to enter precise values.

• Right/double-click for non-numerical options.

Effect properties are integral to the Animation system. When you modify an effect property, a keyframe is generated at
the current playhead position. For a property to span the entire clip, position the playhead at or before the clip’s start
before making adjustments. A convenient way to identify a clip’s start is by utilizing the ‘next/previous marker’ feature
on the Timeline toolbar.

1.9.1 List of Effects

OpenShot Video Editor has a total of 27 built-in video and audio effects: 18 video effects and 9 audio effects. These
effects can be added to a clip by dragging the effect onto a clip. The following table contains the name and short
description of each effect.

1.9. Effects 50



OpenShot Video Editor Documentation, Release 3.1.1

Effect Name Effect Description
Alpha Mask / Wipe Transi-
tion

Grayscale mask transition between images.

Bars Add colored bars around your video.
Blur Adjust image blur.
Brightness & Contrast Modify frame’s brightness and contrast.
Caption Add text captions to any clip.
Chroma Key (Greenscreen) Replace color with transparency.
Color Saturation Adjust color intensity.
Color Shift Shift image colors in various directions.
Crop Crop out parts of your video.
Deinterlace Remove interlacing from video.
Hue Adjust hue / color.
Negative Produce a negative image.
Object Detector Detect objects in video.
Pixelate Increase or decrease visible pixels.
Shift Shift image in different directions.
Stabilizer Reduce video shake.
Tracker Track bounding box in video.
Wave Distort image into a wave pattern.
Compressor Reduce loudness or amplify quiet sounds.
Delay Adjust audio-video synchronism.
Distortion Clip audio signal for distortion.
Echo Add delayed sound reflection.
Expander Make loud parts relatively louder.
Noise Add random equal-intensity signals.
Parametric EQ Adjust frequency volume in audio.
Robotization Transform audio into robotic voice.
Whisperization Transform audio into whispers.

1.9.2 Effect Properties

Below is a list of common effect properties, shared by all effects in OpenShot. To view an effect’s properties, right
click and choose Properties. The property editor will appear, where you can change these properties. Note: Pay close
attention to where the play-head (i.e. red playback line) is. Key frames are automatically created at the current playback
position, to help quickly create animations.

See the table below for a list of common effect properties. Only the common properties that all effects share are
listed here. Each effect also has many unique properties, which are specific to each effect, see Video Effects for more
information on individual effects and their unique properties.
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Effect Property
Name

Type Description

Duration Float The length of the effect (in seconds). Read-only property. Most effects de-
fault to the length of a clip. This property is hidden when an effect belongs
to a clip.

End Float The end trimming position of the effect (in seconds). This property is hid-
den when an effect belongs to a clip.

ID String A randomly generated GUID (globally unique identifier) assigned to each
effect. Read-only property.

Parent String The parent object to this effect, which makes many of these keyframe values
initialize to the parent value.

Position Float The position of the effect on the timeline (in seconds). This property is
hidden when an effect belongs to a clip.

Start Float The start trimming position of the effect (in seconds). This property is hid-
den when an effect belongs to a clip.

Track Int The layer which holds the effect (higher tracks are rendered on top of lower
tracks). This property is hidden when an effect belongs to a clip.

Duration

The Duration property is a float value indicating the length of the effect in seconds. This is a Read-only property. This
is calculated by: End - Start. To modify duration, you must edit the Start and/or End effect properties.

NOTE: Most effects in OpenShot default the effect duration to the clip duration, and hide this property from the editor.

End

The End property defines the trimming point at the end of the effect in seconds, allowing you to control how much of
the effect is visible in the timeline. Changing this property will impact the Duration effect property.

NOTE: Most effects in OpenShot default this property to match the clip, and hide this property from the editor.

ID

The ID property holds a randomly generated GUID (Globally Unique Identifier) assigned to each effect, ensuring its
uniqueness. This is a Read-only property, and assigned by OpenShot when an effect is created.

Track

The Track property is an integer indicating the layer on which the effect is placed. Effects on higher tracks are rendered
above those on lower tracks.

NOTE: Most effects in OpenShot default this property to match the clip, and hide this property from the editor.
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1.9.3 Effect Parent

The Parent property of an effect sets the initial keyframe values to a parent effect. For example, if many effects all
point to the same parent effect, they will inherit all their initial properties, such as font size, font color, and background
color for a Caption effect. In the example of many Caption effects using the same Parent effect, it is an efficient way
to manage a large number of these effects.

NOTE: The parent property for effects should be linked to the same type of parent effect, otherwise their default
initial values will not match. Also see Clip Parent.

Position

The Position property determines the effect’s position on the timeline in seconds, with 0.0 indicating the beginning.

NOTE: Most effects in OpenShot default this property to match the clip, and hide this property from the editor.

Start

The Start property defines the trimming point at the beginning of the effect in seconds. Changing this property will
impact the Duration effect property.

NOTE: Most effects in OpenShot default this property to match the clip, and hide this property from the editor.

1.9.4 Sequencing

Effects are normally applied before the Clip processes keyframes. This allows the effect to process the raw image
of the clip, before the clip applies properties such as scaling, rotation, location, etc. . . Normally, this is the preferred
sequence of events, and this is the default behavior of effects in OpenShot. However, you can optionally override this
behavior with the Apply Before Clip Keyframes property.

If you set the Apply Before Clip Keyframes property to No, the effect will be sequenced after the clip scales,
rotates, and applies keyframes to the image. This can be useful on certain effects, such as the Mask effect, when you
want to animate a clip first and then apply a static mask to the clip.

1.9.5 Video Effects

Effects are generally divided into two categories: video and audio effects. Video effects modify the image and pixel
data of a clip. Below is a list of video effects, and their properties. Often it is best to experiment with an effect, entering
different values into the properties, and observing the results.

Alpha Mask / Wipe Transition

Uses a grayscale mask image to gradually wipe / transition between 2 images (only affects the image, and not the audio
track)
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Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
brightness (float, -1 to 1) This curve controls the motion across the wipe
contrast (float, 0 to 20) This curve controls the hardness and softness of the wipe edge
reader (reader) This reader can use any image or video as input for your grayscale wipe
replace_image (bool, choices: ['Yes', 'No']) Replace the clips image with the current

grayscale wipe image, useful for troubleshooting

Bars

Add colored bars around your video.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
bottom (float, 0 to 0.5) The curve to adjust the bottom bar size
color (color) The curve to adjust the color of bars
left (float, 0 to 0.5) The curve to adjust the left bar size
right (float, 0 to 0.5) The curve to adjust the right bar size
top (float, 0 to 0.5) The curve to adjust the top bar size

Blur

Adjust the blur of the frame’s image.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
horizontal_radius (float, 0 to 100)Horizontal blur radius keyframe. The size of the horizontal blur

operation in pixels.
iterations (float, 0 to 100) Iterations keyframe. The # of blur iterations per pixel. 3 itera-

tions = Gaussian.
sigma (float, 0 to 100) Sigma keyframe. The amount of spread in the blur operation.

Should be larger than radius.
vertical_radius (float, 0 to 100) Vertical blur radius keyframe. The size of the vertical blur op-

eration in pixels.

Brightness & Contrast

Adjust the brightness and contrast of the frame’s image.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
brightness (float, -1 to 1) The curve to adjust the brightness
contrast (float, 0 to 100) The curve to adjust the contrast (3 is typical, 20 is a lot, 100 is

max. 0 is invalid)
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Caption

Add text captions on top of your video. We support both VTT (WebVTT) and SubRip (SRT) subtitle file formats. These
formats are used to display captions or subtitles in videos. They allow you to add text-based subtitles to video content,
making it more accessible to a wider audience, especially for those who are deaf or hard of hearing. The Caption
effect can even animate the text fading in/out, and supports any font, size, color, and margin. OpenShot also has an
easy-to-use Caption editor, where you can quickly insert captions at the playhead position, or edit all your caption text
in one place.

Listing 4: Show a caption, starting at 5 seconds and ending at 10 seconds.

00:00:05.000 --> 00:00:10.000
Hello, welcome to our video!

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
background (color) Color of caption area background
background_alpha (float, 0 to 1) Background color alpha
background_corner (float, 0 to 60) Background corner radius
background_padding (float, 0 to 60) Background padding
caption_font (font) Font name or family name
caption_text (caption) VTT/Subrip formatted caption text (multi-line)
color (color) Color of caption text
fade_in (float, 0 to 3) Fade in per caption (# of seconds)
fade_out (float, 0 to 3) Fade out per caption (# of seconds)
font_alpha (float, 0 to 1) Font color alpha
font_size (float, 0 to 200) Font size in points
left (float, 0 to 0.5) Size of left margin
line_spacing (float, 0 to 5) Distance between lines (1.0 default)
right (float, 0 to 0.5) Size of right margin
stroke (color) Color of text border / stroke
stroke_width (float, 0 to 10)Width of text border / stroke
top (float, 0 to 1) Size of top margin

Chroma Key (Greenscreen)

Replaces the color (or chroma) of the frame with transparency (i.e. keys out the color).

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
color (color) The color to match
fuzz (float, 0 to 125) The fuzz factor (or threshold)
halo (float, 0 to 125) The additional threshold for halo elimination.
keymethod (int, choices: ['Basic keying', 'HSV/HSL hue', 'HSV saturation',

'HSL saturation', 'HSV value', 'HSL luminance', 'LCH luminosity',
'LCH chroma', 'LCH hue', 'CIE Distance', 'Cb,Cr vector']) The
keying method or algorithm to use.
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Color Saturation

Adjust the color saturation.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
saturation (float, 0 to 4) The curve to adjust the overall saturation of the frame’s image (0.0

= greyscale, 1.0 = normal, 2.0 = double saturation)
saturation_B (float, 0 to 4) The curve to adjust blue saturation of the frame’s image
saturation_G (float, 0 to 4) The curve to adjust green saturation of the frame’s image (0.0 =

greyscale, 1.0 = normal, 2.0 = double saturation)
saturation_R (float, 0 to 4) The curve to adjust red saturation of the frame’s image

Color Shift

Shift the colors of an image up, down, left, and right (with infinite wrapping).

Each pixel has 4 color channels:

• Red, Green, Blue, and Alpha (i.e. transparency)

• Each channel value is between 0 and 255

The Color Shift effect simply “moves” or “translates” a specific color channel on the X or Y axis. Not all video and
image formats support an alpha channel, and in those cases, you will not see any changes when adjusting the color
shift of the alpha channel.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
alpha_x (float, -1 to 1) Shift the Alpha X coordinates (left or right)
alpha_y (float, -1 to 1) Shift the Alpha Y coordinates (up or down)
blue_x (float, -1 to 1) Shift the Blue X coordinates (left or right)
blue_y (float, -1 to 1) Shift the Blue Y coordinates (up or down)
green_x (float, -1 to 1) Shift the Green X coordinates (left or right)
green_y (float, -1 to 1) Shift the Green Y coordinates (up or down)
red_x (float, -1 to 1) Shift the Red X coordinates (left or right)
red_y (float, -1 to 1) Shift the Red Y coordinates (up or down)

Crop

Crop out any part of a video clip. This effect is the primary method for cropping a Clip in OpenShot. The left, right,
top, and bottom key-frames can even be animated, for a moving and resizing cropped area. You can leave the cropped
area blank, or you can dynamically resize the cropped area to fill the screen.
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Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
bottom (float, 0 to 1) Size of bottom bar
left (float, 0 to 1) Size of left bar
right (float, 0 to 1) Size of right bar
top (float, 0 to 1) Size of top bar
x (float, -1 to 1) X-offset
y (float, -1 to 1) Y-offset
resize (bool, choices: ['Yes', 'No']) Replace the frame image with the cropped

area (allows automatic scaling of the cropped image)

Deinterlace

Remove interlacing from a video (i.e. even or odd horizontal lines)

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
isOdd (bool, choices: ['Yes', 'No']) Use odd or even lines

Hue

Adjust the hue / color of the frame’s image.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
hue (float, 0 to 1) The curve to adjust the percentage of hue shift

Negative

Negates the colors, producing a negative of the image.

Object Detector

Detect objects through the video.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
class_filter (string) Type of object class to filter (i.e. car, person)
confidence_threshold (float, 0 to 1)Minimum confidence value to display the detected objects
display_box_text (int, choices: ['Off', 'On']) Draw a rectangle around detected objects
objects (list) List of detected object ids
selected_object_index (int, 0 to 200) Index of the tracked object that was selected to modify its proper-

ties

1.9. Effects 57



OpenShot Video Editor Documentation, Release 3.1.1

Pixelate

Pixelate (increase or decrease) the number of visible pixels.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
bottom (float, 0 to 1) The curve to adjust the bottom margin size
left (float, 0 to 1) The curve to adjust the left margin size
pixelization (float, 0 to 0.99) The curve to adjust the amount of pixelization
right (float, 0 to 1) The curve to adjust the right margin size
top (float, 0 to 1) The curve to adjust the top margin size

Shift

Shift the image up, down, left, and right (with infinite wrapping).

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
x (float, -1 to 1) Shift the X coordinates (left or right)
y (float, -1 to 1) Shift the Y coordinates (up or down)

Stabilizer

Stabilize video clip to remove undesired shaking and jitter.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
zoom (float, 0 to 2) Percentage to zoom into the clip, to crop off the shaking and un-

even edges

Tracker

Track the selected bounding box through the video. The tracked object can be selected as a parent on other clips. See
Clip Parent.

Wave

Distort the frame’s image into a wave pattern.
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Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
amplitude (float, 0 to 5) The height of the wave
multiplier (float, 0 to 10) Amount to multiply the wave (make it bigger)
shift_x (float, 0 to 1000) Amount to shift X-axis
speed_y (float, 0 to 300) Speed of the wave on the Y-axis
wavelength (float, 0 to 3) The length of the wave

1.9.6 Audio Effects

Audio effects modify the waveforms and audio sample data of a clip. Below is a list of audio effects, and their properties.
Often it is best to experiment with an effect, entering different values into the properties, and observing the results.

Compressor

Reduce the volume of loud sounds or amplify quiet sounds.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
attack (float, 0.1 to 100)
bypass (bool)
makeup_gain (float, -12 to 12)
ratio (float, 1 to 100)
release (float, 10 to 1000)
threshold (float, -60 to 0)

Delay

Adjust the synchronism between the audio and video track.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
delay_time (float, 0 to 5)

Distortion

Alter the audio by clipping the signal.
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Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
distortion_type (int, choices: ['Hard Clipping', 'Soft Clipping', 'Exponential',

'Full Wave Rectifier', 'Half Wave Rectifier'])
input_gain (int, -24 to 24)
output_gain (int, -24 to 24)
tone (int, -24 to 24)

Echo

Reflection of sound with a delay after the direct sound.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
echo_time (float, 0 to 5)
feedback (float, 0 to 1)
mix (float, 0 to 1)

Expander

Louder parts of audio become relatively louder and quieter parts become quieter.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
attack (float, 0.1 to 100)
bypass (bool)
makeup_gain (float, -12 to 12)
ratio (float, 1 to 100)
release (float, 10 to 1000)
threshold (float, -60 to 0)

Noise

Random signal having equal intensity at different frequencies.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
level (int, 0 to 100)
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Parametric EQ

Filter that allows you to adjust the volume level of a frequency in the audio track.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
filter_type (int, choices: ['Low Pass', 'High Pass', 'Low Shelf', 'High

Shelf', 'Band Pass', 'Band Stop', 'Peaking Notch'])
frequency (int, 20 to 20000)
gain (int, -24 to 24)
q_factor (float, 0 to 20)

Robotization

Transform the voice present in an audio track into a robotic voice effect.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
fft_size (int, choices: ['128', '256', '512', '1024', '2048'])
hop_size (int, choices: ['1/2', '1/4', '1/8'])
window_type (int, choices: ['Rectangular', 'Bart Lett', 'Hann', 'Hamming'])

Whisperization

Transform the voice present in an audio track into a whispering voice effect.

Property Name Description
apply_before_clip (bool, choices: ['Yes', 'No']) Apply this effect before the Clip processes

keyframes? (default is Yes)
fft_size (int, choices: ['128', '256', '512', '1024', '2048'])
hop_size (int, choices: ['1/2', '1/4', '1/8'])
window_type (int, choices: ['Rectangular', 'Bart Lett', 'Hann', 'Hamming'])

For more info on key frames and animation, see Animation.

1.10 Export

Exporting converts your OpenShot project (clips, effects, animations, titles) into a single video output file (using a
process called video encoding). By using the default settings, the exported video will be compatible with most
media players (such as VLC) and websites (such as YouTube, Vimeo, Facebook) and creates a MP4 (h.264 + AAC)
formatted video file. See MP4 (h.264).

Click on the Export Video icon at the top of the screen (or use the File→Export Video menu). The default values will
work fine, so just click the Export Video button to render your new video. You can also create your own custom export
profiles, see Profiles.
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1.10.1 Simple Mode

While video encoding is very complicated, with dozens of interrelated settings and options, OpenShot makes it easy,
with sensible defaults, and most of this complexity hidden away behind our Simple tab, which is the default export
view.
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Simple Setting Description
Profile Common presets (combinations of presets and video profiles grouped by category, for

example: Web)
Target Target presets related to the current profile (collections of common formats, codecs,

and quality settings, see Preset List)
Video Profile Video profiles related to the current target (collections of common size, frame rate,

and aspect ratios, see Profile List or create your own Profiles)
Quality Quality settings (low, med, high), which relate to various video and audio bitrates.

1.10.2 Advanced Mode

Most users will never need to switch to the Advanced tab, but if you need to customize any of the video encoding
settings, for example, custom bitrates, different codecs, or limiting the range of frames exported, this is the tab for you.
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Advanced Options

Advanced Setting Description
Export To Export both video & audio, only audio, only video, or an image sequence
Start Frame The first frame to export (default is 1)
End Frame The final frame to export (default is the last frame in your project to contain a clip)
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Profile

A video profile is a collection of common video settings (size, frame rate, aspect ratio). Profiles are used during
editing, previewing, and exporting to provide a quick way to switch between common combinations of these settings.
The Export Dialog will default to the same profile used by the project.

NOTE: It is important to choose a **Profile* with the same aspect ratio used when editing your project. If you are
exporting at a different aspect ratio, it might stretch the image, crop the image, add black bars, or otherwise introduce
an issue which changes the exported video, making it appear differently than the Preview inside OpenShot.*
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Profile Setting Description
Profile The video profile to use during export (collection of size, frame rate, and aspect ratios,

see Profile List)
Width The width of the video export (in pixels)
Height The height of the video export (in pixels)
Aspect Ratio The aspect ratio of the final exported video. 1920x1080 reduces to 16:9. This also

takes into account the pixel ratio, for example 2:1 rectangular pixels will affect the
aspect ratio.

Pixel Ratio The ratio representing pixel shape. Most video profiles use a 1:1 square pixel shape,
but others will use rectangular pixels.

Frame Rate The frequency that the frames will be displayed at.
Interlaced Is this format used on alternating scan lines (i.e. broadcast and analog formats)
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Image Sequence Settings

Image Setting Name Description
Image Format The string format that represents the output file name in an sequence of images. For

example, %05d.png would pad a number with 5 digits: 00001.png, 00002.png.
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Video Settings

Video Setting Name Description
Video Format The name of the container format (mp4, mov, avi, webm, etc. . . )
Video Codec The name of the video codec used during video encoding (libx264, mpeg4,

libaom-av1, etc. . . )
Bit Rate / Quality The bitrate to use for video encoding. Accepts the following formats: 5 Mb/s, 96

kb/s, 23 crf, etc. . .
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Audio Settings

Audio Setting Name Description
Audio Codec The name of the audio codec used during audio encoding (aac, mp2, libmp3lame,

etc. . . )
Sample Rate The number of audio samples per second. Common values are 44100 and 48000.
Channel Layout The number and layout of audio channels (Stereo, Mono, Surround, etc. . . )
Bit Rate / Quality The bitrate to use for audio encoding. Accepts the following formats: 96 kb/s, 128

kb/s, 192 kb/s, etc. . .
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1.11 Animation

OpenShot has been designed specifically with animation in mind. The powerful curve-based animation framework can
handle most jobs with ease, and is flexible enough to create just about any animation. Key frames specify values at
certain points on a clip, and OpenShot does the hard work of interpolating the in-between values.

1.11.1 Overview

# Name Description
1 Green Property When the play-head is on a key frame, the property appears green
1 Blue Property When the play-head is on an interpolated value, the property appears blue
2 Value Slider Click and drag your mouse to adjust the value (this automatically creates a key

frame if needed)
3 Play-head Position the play-head over a clip where you need a key frame
4 Key frame Markers Small icons are displayed on the bottom of the clip for each active keyframe (cir-

cle=Bézier, diamond=linear, square=constant). These icons are filtered based
on the property window. For example, if you filter only scale_x, you will only
see the icons for scale_x keyframes, for example.
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1.11.2 Key Frames

To create a key frame in OpenShot, simply position the play-head (i.e. playback position) at any point over a clip,
and edit properties in the property dialog. If the property supports key frames, it will turn green, and a small icon
(circle=Bézier, diamond=linear, square=constant) will appear on the bottom of your clip at that position. Move your
play-head to another point over that clip, and adjust the properties again. All animations require at least 2 key frames,
but can support an unlimited number of them.

To adjust the interpolation mode, right click on the small graph icon next to a property value.

Key-frame Inter-
polation

Description

Bézier Interpolated values use a quadratic curve, and ease-in and ease-out
Linear Interpolated values are calculated linear (each step value is equal)
Constant Interpolated values stay the same until the next key frame, and jump to the new value

For more info on creating key frames for location, rotation, scale, shear, and location, see Transform.
For more info on preset animations, see Context Menu.
For a full list of key frames, see Clip Properties.

1.11.3 Bézier Presets

When using a Bézier curve for animation, OpenShot includes more than 20 curve presets (which affect the shape of
the curve). For example, Ease-In has a more gradual slope at the beginning, making an animation move slower at the
beginning, and faster at the end. Ease-In/Out (Back) has a gradual beginning and ending, but actually goes past the
expected value and then back (producing a bounce effect).

To choose a curve preset, right click on the small graph icon next to a key frame.
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1.11.4 Image Sequences

If you have a sequence of similarly named images (such as, cat001.png, cat002.png, cat003.png, etc. . . ), you can simply
drag and drop one of them into OpenShot, and you will be prompted to import the entire sequence. OpenShot will
playback these sequential images rapidly, as if they are frames in a video. The rate or speed in which these images are
displayed is based on their frame rate.
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To adjust the frame rate of the animation, right click and choose File Properties in the Project Files panel, and adjust
the frame rate. Once you have set the correct frame rate, drag the animation onto the timeline.

# Name Description
1 File Properties Select an image sequence in the Project Files panel, right click and choose File Prop-

erties
2 Frame Rate Adjust the frame rate of the animation. Typically, hand-drawn animations use 12 frames

per second.
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1.12 Text & Titles

Adding text and titles is an important aspect of video editing, and OpenShot comes with an easy-to-use Title Editor.
Use the Title menu (located in the main menu of OpenShot) to launch the Title Editor. You can also use the keyboard
shortcut Ctrl+T.

Titles are simply vector image files with transparent backgrounds (*.svg). OpenShot comes with many easy-to-use
templates, but you can also create your own or import new templates into OpenShot. These templates allow you to
quickly change the text, font, size, color, and background color. You can also launch an advanced, external SVG editor
for further customizations (if needed). Once the title is added to your project, drag and drop the title on a Track above
a video clip. The transparent background will allow the video below to appear behind the text.

1.12.1 Overview

# Name Description
1 Choose a Template Choose from any available vector title template
2 Preview Title Preview your title as you make changes
3 Title Properties Change the text, font, size, colors, or edit in an advanced, external SVG

image editor (such as Inkscape)
4 Save Save and add the title to your project
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1.12.2 Custom Title Templates

OpenShot can use any vector SVG image file as a custom title template in the Title Editor dialog. Just add an SVG
image file to your ~/.openshot_qt/title_templates/ folder, and it will appear the next time you launch the Title
Editor dialog. You can also right click on any SVG files in your Project Files panel, and choose Edit Title or Duplicate
Title.

Note: These SVG templates are only used by the Title Editor dialog, and not Animated Title dialog.

1.12.3 3D Animated Titles

Adding a 3D animated title is just as easy, using our Animated Title dialog. Use the Title menu (located in the main
menu of OpenShot) to launch the Animated Title editor. You can also use the keyboard shortcut Ctrl+B. Note: Blender
must be installed and configured before this feature will work in OpenShot. See Installing Blender.

# Name Description
1 Choose a Template Choose from any available 3D title templates
2 Preview Title Preview your title as you make changes
3 Title Properties Change the text, colors, and advanced properties
4 Render Render the 3D animation, and add it to your project
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1.12.4 Importing Text

You can generate text & titles in many different programs, such as Blender, Inkscape, Krita, Gimp, etc. . . Before you
can import text into OpenShot, you must first export the text from these programs into a compatible image format that
contains a transparent background and alpha channel.

The SVG format is a great choice for vector graphics (curves, shapes, text effects and paths), however it is not always
100% compatible with OpenShot. Thus, we recommend using PNG format, which is a great web-based image format
that can include a transparent background and alpha channel. A transparent background and alpha channel are needed
for OpenShot to allow the text to not cover up videos and images on the timeline below them.

For information on importing animated sequences into OpenShot, please see Image Sequences.

1.12.5 Installing Inkscape

The Advanced Editor feature in the Title Editor dialog requires the latest version of Inkscape (https://inkscape.org/
release/) be installed and the OpenShot Preferences updated with the correct path to the Inkscape executable. See the
General tab in Preferences.

1.12.6 Installing Blender

The Animated Title feature in OpenShot requires the latest version of Blender (https://www.blender.org/download/) be
installed and the OpenShot Preferences updated with the correct path to the Blender executable. See the General tab in
Preferences. NOTE: The minimum supported version of Blender is 2.8+. Older versions of Blender are not compatible
with OpenShot Video Editor.

For a detailed guide on how to install these dependencies, see Blender & Inkscape Guide.

1.13 Profiles

A video profile is a collection of common video settings (size, frame rate, aspect ratio). Profiles are used during editing,
previewing, and exporting to provide a quick way to switch between common combinations of these settings.

If you often use the same profile, you can set a default profile: Edit→Preferences→Preview.

1.13.1 Project Profile

The project profile is used when previewing your project and editing. The default project profile is HD 720p 30fps. It
is best practice to always switch to your target profile before you begin editing. For example, if you are targeting 1080p
30fps, switch to that profile before you begin editing your project. For a full list of included profiles see Profile List.
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# Name Description
1 Title Bar The title bar of OpenShot displays the current profile
2 Profile Button Launch the profiles dialog
3 Choose Profile Select a profile for editing and preview
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1.13.2 Choose Profile Dialog

# Name Description
1 Filter / Search Filter the available profiles by typing a few characters (i.e. FHD, 720p, 16:9, etc. . . )
2 Selected Pro-

file
Click on the desired profile, and then the OK button. You can also double click a profile to
select it.

3 Filtered Count Count of filtered profiles
4 Accept Profile Click the OK button to switch to the selected profile.

1.13.3 Export Profile

The export profile always defaults to your current project profile, but can be changed to target different profiles.
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# Name Description
1 Choose

Profile
Select an export profile from a dropdown. This list is sorted from largest resolution at the top,
smallest resolution at the bottom.

2 Search
Profiles

Open Profile dialog to filter and search for an export profile, which can sometimes be much
quicker to find a specific profile.
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1.13.4 Custom Profile

Although OpenShot has more than 400 profiles (Profile List) included by default, you can also create your own cus-
tom profiles. Create a new text file in the ~/.openshot_qt/profiles/ or C:\Users\USERNAME\.openshot_qt\
profiles folder. Use the following text as your template (i.e. copy and paste this into the new file):

description=Custom Profile Name
frame_rate_num=30000
frame_rate_den=1001
width=1280
height=720
progressive=1
sample_aspect_num=1
sample_aspect_den=1
display_aspect_num=16
display_aspect_den=9

Profile Property Description
description The friendly name of the profile (this is what OpenShot displays in the user inter-

face)
frame_rate_num The frame rate numerator. All frame rates are expressed as fractions. For example,

30 FPS == 30/1.
frame_rate_den The frame rate denominator. All frame rates are expressed as fractions. For ex-

ample, 29.97 FPS == 30,000/1001.
width The number of horizontal pixels in the image. By reversing the values for width

and height, you can create a vertical profile.
height The number of vertical pixels in the image
progressive `(0 or 1)` If 1, both even and odd rows of pixels are used. If 0, only odd or

even rows of pixels are used.
sample_aspect_num The numerator of the SAR (sample/pixel shape aspect ratio), 1:1 ratio would

represent a square pixel, 2:1 ratio would represent a 2x1 rectangle pixel shape,
etc. . .

sample_aspect_den The denominator of the SAR (sample/pixel shape aspect ratio)
display_aspect_num The numerator of the DAR (display aspect ratio), (width/height) X (sample

aspect ratio). This is the final ratio of the image displayed on screen, reduced
to the smallest fraction possible (common ratios are 16:9 for wide formats, 4:3 for
legacy television formats).

display_aspect_den The denominator of the DAR (display aspect ratio)

Once you restart OpenShot, you will see your custom profile appear in the list of Profiles.

1.13.5 Preset List

OpenShot includes many export presets, which combine our list of common profiles and their associated video export
settings (video codec, audio codec, audio channels, audio sample rate, etc. . . ), which target specific output
formats, websites, and devices. The default export preset used by OpenShot is MP4 (h.264 + AAC), see MP4
(h.264).

1.13. Profiles 81



OpenShot Video Editor Documentation, Release 3.1.1

All Formats

AVI (h.264)

Preset Attribute Description
Video Format AVI
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

AVI (mpeg2)

Preset Attribute Description
Video Format AVI
Video Codec mpeg2video
Audio Codec mp2
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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AVI (mpeg4)

Preset Attribute Description
Video Format AVI
Video Codec mpeg4
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

GIF (animated)

Preset Attribute Description
Video Format GIF
Video Codec gif
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Profiles

All Profiles

1.13. Profiles 83



OpenShot Video Editor Documentation, Release 3.1.1

MKV (h.264 dx)

Preset Attribute Description
Video Format MKV
Video Codec h264_dxva2
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MKV (h.264 nv)

Preset Attribute Description
Video Format MKV
Video Codec h264_nvenc
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MKV (h.264 qsv)

Preset Attribute Description
Video Format MKV
Video Codec h264_qsv
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MKV (h.264 va)

Preset Attribute Description
Video Format MKV
Video Codec h264_vaapi
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MKV (h.264 videotoolbox)

Preset Attribute Description
Video Format MKV
Video Codec h264_videotoolbox
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MKV (h.264)

Preset Attribute Description
Video Format MKV
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MKV (h.265)

Preset Attribute Description
Video Format MKV
Video Codec libx265
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 50 crf
Video Bitrate (med) 23 crf
Video Bitrate (high) 0 crf
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MOV (h.264)

Preset Attribute Description
Video Format MOV
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MOV (mpeg2)

Preset Attribute Description
Video Format MOV
Video Codec mpeg2video
Audio Codec mp2
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MOV (mpeg4)

Preset Attribute Description
Video Format MOV
Video Codec mpeg4
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MP3 (audio only)

Preset Attribute Description
Video Format MP3
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MP4 (AV1 rav1e)

Preset Attribute Description
Video Format MP4
Video Codec librav1e
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 200 qp
Video Bitrate (med) 100 qp
Video Bitrate (high) 50 qp
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MP4 (AV1 svt)

Preset Attribute Description
Video Format MP4
Video Codec libsvtav1
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 60 qp
Video Bitrate (med) 50 qp
Video Bitrate (high) 30 qp
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MP4 (HEVC va)

Preset Attribute Description
Video Format MP4
Video Codec hevc_vaapi
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MP4 (Xvid)

Preset Attribute Description
Video Format MP4
Video Codec libxvid
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MP4 (h.264 dx)

Preset Attribute Description
Video Format MP4
Video Codec h264_dxva2
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MP4 (h.264 nv)

Preset Attribute Description
Video Format MP4
Video Codec h264_nvenc
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MP4 (h.264 qsv)

Preset Attribute Description
Video Format MP4
Video Codec h264_qsv
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MP4 (h.264 va)

Preset Attribute Description
Video Format MP4
Video Codec h264_vaapi
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MP4 (h.264 videotoolbox)

Preset Attribute Description
Video Format MP4
Video Codec h264_videotoolbox
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MP4 (h.264)

This is the default export preset used by OpenShot. This format is compatible with most media players (such as VLC)
and websites (such as YouTube, Vimeo, Facebook).
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Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MP4 (h.265)

Preset Attribute Description
Video Format MP4
Video Codec libx265
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 50 crf
Video Bitrate (med) 23 crf
Video Bitrate (high) 0 crf
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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MP4 (mpeg4)

Preset Attribute Description
Video Format MP4
Video Codec mpeg4
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

MPEG (mpeg2)

Preset Attribute Description
Video Format MPEG
Video Codec mpeg2video
Audio Codec mp2
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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OGG (theora/flac)

Preset Attribute Description
Video Format OGG
Video Codec libtheora
Audio Codec flac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

OGG (theora/vorbis)

Preset Attribute Description
Video Format OGG
Video Codec libtheora
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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WEBM (vp9)

Preset Attribute Description
Video Format WEBM
Video Codec libvpx-vp9
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 50 crf
Video Bitrate (med) 30 crf
Video Bitrate (high) 5 crf
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

WEBM (vp9) lossless

Preset Attribute Description
Video Format WEBM
Video Codec libvpx-vp9
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 50 crf
Video Bitrate (med) 23 crf
Video Bitrate (high) 0 crf
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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WEBM (vpx)

Preset Attribute Description
Video Format WEBM
Video Codec libvpx
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

WEBP (vp9 va)

Preset Attribute Description
Video Format WEBM
Video Codec vp9_vaapi
Audio Codec libopus
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles
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Device

Apple TV

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (high) 5 Mb/s
Audio Bitrate (high) 256 kb/s
Profiles

HD 720p 30 fps

Chromebook

Preset Attribute Description
Video Format WEBM
Video Codec libvpx
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

All Profiles

1.13. Profiles 99



OpenShot Video Editor Documentation, Release 3.1.1

Nokia nHD

Preset Attribute Description
Video Format AVI
Video Codec libxvid
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 1 Mb/s
Video Bitrate (med) 3 Mb/s
Video Bitrate (high) 5 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

NTSC SD 1/4 QVGA 240p 29.97 fps

Xbox 360

Preset Attribute Description
Video Format AVI
Video Codec libxvid
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 2 Mb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 8 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

FHD 1080p 29.97 fps
HD 720p 29.97 fps
NTSC SD Widescreen Anamorphic 480i 29.97 fps
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Web

Flickr-HD

Preset Attribute Description
Video Format MOV
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

FHD 1080p 29.97 fps
FHD PAL 1080p 25 fps
HD 720p 25 fps
HD 720p 29.97 fps
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Instagram

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 3.5 Mb/s
Video Bitrate (high) 5.50 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

FHD 1080p 30 fps
FHD PAL 1080p 25 fps
FHD Vertical 1080p 25 fps
FHD Vertical 1080p 30 fps
HD 720p 25 fps
HD 720p 30 fps
HD Vertical 720p 25 fps
HD Vertical 720p 30 fps

Metacafe

Preset Attribute Description
Video Format MP4
Video Codec mpeg4
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 44100
Video Bitrate (low) 2 Mb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 8 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

NTSC SD SQ VGA 480p 29.97 fps
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Picasa

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 44100
Video Bitrate (low) 2 Mb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 8 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

NTSC SD SQ VGA 480p 29.97 fps

Twitter

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 1.7 Mb/s
Video Bitrate (high) 3.5 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

FHD 1080p 30 fps
FHD PAL 1080p 25 fps
FHD Vertical 1080p 25 fps
FHD Vertical 1080p 30 fps
HD 720p 25 fps
HD 720p 30 fps
HD Vertical 720p 25 fps
HD Vertical 720p 30 fps
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Vimeo

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 2 Mb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 8 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

NTSC SD SQ VGA 480p 29.97 fps
NTSC SD Wide FWVGA 480p 29.97 fps

Vimeo-HD

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 4 Mb/s
Video Bitrate (med) 8 Mb/s
Video Bitrate (high) 12 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

FHD 1080p 23.98 fps
FHD 1080p 24 fps
FHD 1080p 29.97 fps
FHD 1080p 30 fps
FHD PAL 1080p 25 fps
HD 720p 23.98 fps
HD 720p 24 fps
HD 720p 25 fps
HD 720p 29.97 fps
HD 720p 30 fps
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Wikipedia

Preset Attribute Description
Video Format OGG
Video Codec libtheora
Audio Codec libvorbis
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 384 kb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 15.00 Mb/s
Audio Bitrate (low) 96 kb/s
Audio Bitrate (med) 128 kb/s
Audio Bitrate (high) 192 kb/s
Profiles

NTSC SD 1/4 QVGA 240p 29.97 fps
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YouTube HD

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 8 Mb/s
Video Bitrate (med) 10 Mb/s
Video Bitrate (high) 12 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

FHD 1080p 23.98 fps
FHD 1080p 24 fps
FHD 1080p 29.97 fps
FHD 1080p 30 fps
FHD 1080p 59.94 fps
FHD 1080p 60 fps
FHD PAL 1080p 25 fps
FHD PAL 1080p 50 fps
FHD Vertical 1080p 23.98 fps
FHD Vertical 1080p 24 fps
FHD Vertical 1080p 25 fps
FHD Vertical 1080p 29.97 fps
FHD Vertical 1080p 30 fps
FHD Vertical 1080p 50 fps
FHD Vertical 1080p 59.94 fps
FHD Vertical 1080p 60 fps
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YouTube HD (2K)

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 16 Mb/s
Video Bitrate (med) 20 Mb/s
Video Bitrate (high) 24 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

2.5K WQHD 1440p 23.98 fps
2.5K WQHD 1440p 24 fps
2.5K WQHD 1440p 25 fps
2.5K WQHD 1440p 29.97 fps
2.5K WQHD 1440p 30 fps
2.5K WQHD 1440p 50 fps
2.5K WQHD 1440p 59.94 fps
2.5K WQHD 1440p 60 fps
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YouTube HD (4K)

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 45 Mb/s
Video Bitrate (med) 56 Mb/s
Video Bitrate (high) 68 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

4K UHD 2160p 23.98 fps
4K UHD 2160p 24 fps
4K UHD 2160p 25 fps
4K UHD 2160p 29.97 fps
4K UHD 2160p 30 fps
4K UHD 2160p 50 fps
4K UHD 2160p 59.94 fps
4K UHD 2160p 60 fps
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YouTube HD (8K)

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 160 Mb/s
Video Bitrate (med) 200 Mb/s
Video Bitrate (high) 240 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

8K UHD 4320p 23.98 fps
8K UHD 4320p 24 fps
8K UHD 4320p 25 fps
8K UHD 4320p 29.97 fps
8K UHD 4320p 30 fps
8K UHD 4320p 50 fps
8K UHD 4320p 59.94 fps
8K UHD 4320p 60 fps
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YouTube Standard

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec libmp3lame
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 2 Mb/s
Video Bitrate (med) 5 Mb/s
Video Bitrate (high) 8 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 256 kb/s
Audio Bitrate (high) 320 kb/s
Profiles

HD 720p 23.98 fps
HD 720p 24 fps
HD 720p 25 fps
HD 720p 29.97 fps
HD 720p 30 fps
HD 720p 59.94 fps
HD 720p 60 fps
HD Vertical 720p 23.98 fps
HD Vertical 720p 24 fps
HD Vertical 720p 25 fps
HD Vertical 720p 29.97 fps
HD Vertical 720p 30 fps
HD Vertical 720p 50 fps
HD Vertical 720p 59.94 fps
HD Vertical 720p 60 fps
NTSC SD SQ VGA 480p 29.97 fps
NTSC SD Wide FWVGA 480p 29.97 fps
PAL HD 720p 50 fps

DVD
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DVD-NTSC

Preset Attribute Description
Video Format DVD
Video Codec mpeg2video
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 1 Mb/s
Video Bitrate (med) 3 Mb/s
Video Bitrate (high) 5 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 192 kb/s
Audio Bitrate (high) 256 kb/s
Profiles

NTSC SD Anamorphic 480i 29.97 fps
NTSC SD Widescreen Anamorphic 480i 29.97 fps

DVD-PAL

Preset Attribute Description
Video Format DVD
Video Codec mpeg2video
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 1 Mb/s
Video Bitrate (med) 3 Mb/s
Video Bitrate (high) 5 Mb/s
Audio Bitrate (low) 128 kb/s
Audio Bitrate (med) 192 kb/s
Audio Bitrate (high) 256 kb/s
Profiles

PAL SD Anamorphic 576i 25 fps
PAL SD Widescreen Anamorphic 576i 25 fps
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Blu-Ray/AVCHD

AVCHD Disks

Preset Attribute Description
Video Format MP4
Video Codec libx264
Audio Codec aac
Audio Channels 2
Audio Channel Layout Stereo
Sample Rate 48000
Video Bitrate (low) 15 Mb/s
Video Bitrate (high) 40 Mb/s
Audio Bitrate (low) 256 kb/s
Audio Bitrate (high) 256 kb/s
Profiles

FHD 1080i 30 fps
FHD PAL 1080i 25 fps
FHD PAL 1080p 25 fps

1.13.6 Profile List

OpenShot includes over 400 built-in video profiles. These profiles match the most common video project sizes and
frame rates used around the world. It is recommended to edit your project using the same profile as you intend to export.
You can also edit your project with different profiles which match your target aspect ratio, for example: all 16:9 profiles
are generally compatible with each other. Sometimes it can be useful to edit a project in a lower resolution profile, and
export in a higher resolution profile. A full list of profiles is provided below.

Profile Definitions

• Profile Name: Short, friendly name for a video profile (e.g., FHD 1080p 30 fps)

• FPS: Frames Per Second

• DAR: Display Aspect Ratio (e.g., 1920:1080 becomes 16:9)

• SAR: Sample Aspect Ratio (e.g., 1:1 square pixel, 2:1 horizontal rectangular pixel). The SAR directly affects
the display aspect ratio. For instance, a 4:3 video can be displayed as 16:9 using rectangular pixels. Non-square
pixels adjust the final display width.

• PAR: Pixel Aspect Ratio (identical to SAR)

• SAR Adjusted Width: Final display width considering SAR

• Interlaced: Alternating odd and even lines, used in analog broadcasting

• NTSC: Analog TV system in America (usually 29.97 fps)

• PAL: Analog TV system in Europe, Australia, and much of the world (usually 25 fps)

• UHD: Ultra High Definition

• QHD: Quad High Definition
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• FHD: Full High Definition

• HD: High Definition (equal or greater than 1280x720 pixels)

• SD: Standard Definition (smaller than 1280x720 pixels)

Profile Name WidthHeightFPSDARSARInter-
laced

SAR Adjusted
Width

16K UHD 8640p 59.94 fps 15360864059.9416:9 1:1 No 15360
16K UHD 8640p 29.97 fps 15360864029.9716:9 1:1 No 15360
16K UHD 8640p 23.98 fps 15360864023.9816:9 1:1 No 15360
16K UHD 8640p 60 fps 15360864060.0016:9 1:1 No 15360
16K UHD 8640p 50 fps 15360864050.0016:9 1:1 No 15360
16K UHD 8640p 30 fps 15360864030.0016:9 1:1 No 15360
16K UHD 8640p 25 fps 15360864025.0016:9 1:1 No 15360
16K UHD 8640p 24 fps 15360864024.0016:9 1:1 No 15360
8K UHD 4320p 59.94 fps 7680432059.9416:9 1:1 No 7680
8K UHD 4320p 29.97 fps 7680432029.9716:9 1:1 No 7680
8K UHD 4320p 23.98 fps 7680432023.9816:9 1:1 No 7680
8K UHD 4320p 60 fps 7680432060.0016:9 1:1 No 7680
8K UHD 4320p 50 fps 7680432050.0016:9 1:1 No 7680
8K UHD 4320p 30 fps 7680432030.0016:9 1:1 No 7680
8K UHD 4320p 25 fps 7680432025.0016:9 1:1 No 7680
8K UHD 4320p 24 fps 7680432024.0016:9 1:1 No 7680
5K UHD 2880p 59.94 fps 5120288059.9416:9 1:1 No 5120
5K UHD 2880p 29.97 fps 5120288029.9716:9 1:1 No 5120
5K UHD 2880p 23.98 fps 5120288023.9816:9 1:1 No 5120
5K UHD 2880p 60 fps 5120288060.0016:9 1:1 No 5120
5K UHD 2880p 50 fps 5120288050.0016:9 1:1 No 5120
5K UHD 2880p 30 fps 5120288030.0016:9 1:1 No 5120
5K UHD 2880p 25 fps 5120288025.0016:9 1:1 No 5120
5K UHD 2880p 24 fps 5120288024.0016:9 1:1 No 5120
4K UHD 2160p 59.94 fps 3840216059.9416:9 1:1 No 3840
4K UHD 2160p 29.97 fps 3840216029.9716:9 1:1 No 3840
4K UHD 2160p 23.98 fps 3840216023.9816:9 1:1 No 3840
4K UHD 2160p 60 fps 3840216060.0016:9 1:1 No 3840
4K UHD 2160p 50 fps 3840216050.0016:9 1:1 No 3840
4K UHD 2160p 30 fps 3840216030.0016:9 1:1 No 3840
4K UHD 2160p 25 fps 3840216025.0016:9 1:1 No 3840
4K UHD 2160p 24 fps 3840216024.0016:9 1:1 No 3840
3K QHD+ 1800p 59.94 fps 3200180059.9416:9 1:1 No 3200
3K QHD+ 1800p 29.97 fps 3200180029.9716:9 1:1 No 3200
3K QHD+ 1800p 23.98 fps 3200180023.9816:9 1:1 No 3200
3K QHD+ 1800p 60 fps 3200180060.0016:9 1:1 No 3200
3K QHD+ 1800p 50 fps 3200180050.0016:9 1:1 No 3200
3K QHD+ 1800p 30 fps 3200180030.0016:9 1:1 No 3200
3K QHD+ 1800p 25 fps 3200180025.0016:9 1:1 No 3200
3K QHD+ 1800p 24 fps 3200180024.0016:9 1:1 No 3200
2.5K WQHD 1440p 59.94 fps 2560144059.9416:9 1:1 No 2560
2.5K WQHD 1440p 29.97 fps 2560144029.9716:9 1:1 No 2560
2.5K WQHD 1440p 23.98 fps 2560144023.9816:9 1:1 No 2560
2.5K WQHD 1440p 60 fps 2560144060.0016:9 1:1 No 2560
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2.5K WQHD 1440p 50 fps 2560144050.0016:9 1:1 No 2560
2.5K WQHD 1440p 30 fps 2560144030.0016:9 1:1 No 2560
2.5K WQHD 1440p 25 fps 2560144025.0016:9 1:1 No 2560
2.5K WQHD 1440p 24 fps 2560144024.0016:9 1:1 No 2560
FHD 1080p 59.94 fps 1920108059.9416:9 1:1 No 1920
FHD 1080p 29.97 fps 1920108029.9716:9 1:1 No 1920
FHD 1080p 23.98 fps 1920108023.9816:9 1:1 No 1920
FHD 1080p 60 fps 1920108060.0016:9 1:1 No 1920
FHD PAL 1080p 50 fps 1920108050.0016:9 1:1 No 1920
FHD 1080p 30 fps 1920108030.0016:9 1:1 No 1920
FHD PAL 1080p 25 fps 1920108025.0016:9 1:1 No 1920
FHD 1080p 24 fps 1920108024.0016:9 1:1 No 1920
FHD 1080i 29.97 fps 1920108029.9716:9 1:1 Yes 1920
FHD 1080i 30 fps 1920108030.0016:9 1:1 Yes 1920
FHD PAL 1080i 25 fps 1920108025.0016:9 1:1 Yes 1920
FHD Anamorphic 1035i 29.97 fps 1920103529.9716:9 23:24Yes 1840
FHD Anamorphic 1035i 30 fps 1920103530.0016:9 23:24Yes 1840
FHD Anamorphic 1035i 25 fps 1920103525.0016:9 23:24Yes 1840
HD+ 900p 59.94 fps 1600900 59.9416:9 1:1 No 1600
HD+ 900p 29.97 fps 1600900 29.9716:9 1:1 No 1600
HD+ 900p 23.98 fps 1600900 23.9816:9 1:1 No 1600
HD+ 900p 60 fps 1600900 60.0016:9 1:1 No 1600
HD+ 900p 50 fps 1600900 50.0016:9 1:1 No 1600
HD+ 900p 30 fps 1600900 30.0016:9 1:1 No 1600
HD+ 900p 25 fps 1600900 25.0016:9 1:1 No 1600
HD+ 900p 24 fps 1600900 24.0016:9 1:1 No 1600
HD Anamorphic 1152i 25 fps 1440115225.0016:9 64:45Yes 2048
HD Anamorphic 1080p 59.94 fps 1440108059.9416:9 4:3 No 1920
HD Anamorphic 1080p 29.97 fps 1440108029.9716:9 4:3 No 1920
HD Anamorphic 1080p 23.98 fps 1440108023.9816:9 4:3 No 1920
HD Anamorphic 1080p 60 fps 1440108060.0016:9 4:3 No 1920
HD Anamorphic 1080p 50 fps 1440108050.0016:9 4:3 No 1920
HD Anamorphic 1080p 30 fps 1440108030.0016:9 4:3 No 1920
HD Anamorphic 1080p 25 fps 1440108025.0016:9 4:3 No 1920
HD Anamorphic 1080p 24 fps 1440108024.0016:9 4:3 No 1920
HD Anamorphic 1080i 29.97 fps 1440108029.9716:9 4:3 Yes 1920
HD Anamorphic 1080i 30 fps 1440108030.0016:9 4:3 Yes 1920
HD Anamorphic 1080i 25 fps 1440108025.0016:9 4:3 Yes 1920
NTSC SD 16CIF Anamorphic 1152p 29.97 fps 1408115229.974:3 12:11No 1536
PAL SD 16CIF Anamorphic 1152p 25 fps 1408115225.004:3 12:11No 1536
PAL SD 16CIF Anamorphic 1152p 15 fps 1408115215.004:3 12:11No 1536
HD 720p 59.94 fps 1280720 59.9416:9 1:1 No 1280
HD 720p 29.97 fps 1280720 29.9716:9 1:1 No 1280
HD 720p 23.98 fps 1280720 23.9816:9 1:1 No 1280
HD 720p 60 fps 1280720 60.0016:9 1:1 No 1280
PAL HD 720p 50 fps 1280720 50.0016:9 1:1 No 1280
HD 720p 30 fps 1280720 30.0016:9 1:1 No 1280
HD 720p 25 fps 1280720 25.0016:9 1:1 No 1280
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HD 720p 24 fps 1280720 24.0016:9 1:1 No 1280
FHD Vertical 1080p 59.94 fps 1080192059.949:16 1:1 No 1080
FHD Vertical 1080p 29.97 fps 1080192029.979:16 1:1 No 1080
FHD Vertical 1080p 23.98 fps 1080192023.989:16 1:1 No 1080
FHD Vertical 1080p 60 fps 1080192060.009:16 1:1 No 1080
FHD Vertical 1080p 50 fps 1080192050.009:16 1:1 No 1080
FHD Vertical 1080p 30 fps 1080192030.009:16 1:1 No 1080
FHD Vertical 1080p 25 fps 1080192025.009:16 1:1 No 1080
FHD Vertical 1080p 24 fps 1080192024.009:16 1:1 No 1080
HD Vertical 1080p 60 fps 1080135060.004:5 1:1 No 1080
HD Vertical 1080p 50 fps 1080135050.004:5 1:1 No 1080
HD Vertical 1080p 30 fps 1080135030.004:5 1:1 No 1080
HD Vertical 1080p 25 fps 1080135025.004:5 1:1 No 1080
HD Vertical 1080p 24 fps 1080135024.004:5 1:1 No 1080
HD Square 1080p 60 fps 1080108060.001:1 1:1 No 1080
HD Square 1080p 50 fps 1080108050.001:1 1:1 No 1080
HD Square 1080p 30 fps 1080108030.001:1 1:1 No 1080
HD Square 1080p 25 fps 1080108025.001:1 1:1 No 1080
HD Square 1080p 24 fps 1080108024.001:1 1:1 No 1080
WSVGA 600p 59.94 fps 1024600 59.94128:751:1 No 1024
WSVGA 600p 29.97 fps 1024600 29.97128:751:1 No 1024
WSVGA 600p 23.98 fps 1024600 23.98128:751:1 No 1024
WSVGA 600p 60 fps 1024600 60.00128:751:1 No 1024
WSVGA 600p 50 fps 1024600 50.00128:751:1 No 1024
WSVGA 600p 30 fps 1024600 30.00128:751:1 No 1024
WSVGA 600p 25 fps 1024600 25.00128:751:1 No 1024
WSVGA 600p 24 fps 1024600 24.00128:751:1 No 1024
WSVGA 600p 15 fps 1024600 15.00128:751:1 No 1024
WSVGA 576p 59.94 fps 1024576 59.9416:9 1:1 No 1024
WSVGA 576p 29.97 fps 1024576 29.9716:9 1:1 No 1024
WSVGA 576p 23.98 fps 1024576 23.9816:9 1:1 No 1024
WSVGA 576p 60 fps 1024576 60.0016:9 1:1 No 1024
WSVGA 576p 50 fps 1024576 50.0016:9 1:1 No 1024
WSVGA 576p 30 fps 1024576 30.0016:9 1:1 No 1024
PAL SD Wide WSVGA 576p 25 fps 1024576 25.0016:9 1:1 No 1024
WSVGA 576p 24 fps 1024576 24.0016:9 1:1 No 1024
WSVGA 576p 15 fps 1024576 15.0016:9 1:1 No 1024
DVGA 640p 59.94 fps 960 640 59.943:2 1:1 No 960
DVGA 640p 29.97 fps 960 640 29.973:2 1:1 No 960
DVGA 640p 23.98 fps 960 640 23.983:2 1:1 No 960
DVGA 640p 60 fps 960 640 60.003:2 1:1 No 960
DVGA 640p 50 fps 960 640 50.003:2 1:1 No 960
DVGA 640p 30 fps 960 640 30.003:2 1:1 No 960
DVGA 640p 25 fps 960 640 25.003:2 1:1 No 960
DVGA 640p 24 fps 960 640 24.003:2 1:1 No 960
DVGA 640p 15 fps 960 640 15.003:2 1:1 No 960
qHD 540p 59.94 fps 960 540 59.9416:9 1:1 No 960
qHD 540p 29.97 fps 960 540 29.9716:9 1:1 No 960
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qHD 540p 23.98 fps 960 540 23.9816:9 1:1 No 960
qHD 540p 60 fps 960 540 60.0016:9 1:1 No 960
qHD 540p 50 fps 960 540 50.0016:9 1:1 No 960
qHD 540p 30 fps 960 540 30.0016:9 1:1 No 960
qHD 540p 25 fps 960 540 25.0016:9 1:1 No 960
qHD 540p 24 fps 960 540 24.0016:9 1:1 No 960
FWVGA 480p 59.94 fps 854 480 59.9416:9 1:1 No 854
NTSC SD Wide FWVGA 480p 29.97 fps 854 480 29.9716:9 1:1 No 854
FWVGA 480p 23.98 fps 854 480 23.9816:9 1:1 No 854
FWVGA 480p 60 fps 854 480 60.0016:9 1:1 No 854
FWVGA 480p 50 fps 854 480 50.0016:9 1:1 No 854
FWVGA 480p 30 fps 854 480 30.0016:9 1:1 No 854
FWVGA 480p 25 fps 854 480 25.0016:9 1:1 No 854
FWVGA 480p 24 fps 854 480 24.0016:9 1:1 No 854
FWVGA 480p 15 fps 854 480 15.0016:9 1:1 No 854
SVGA 600p 59.94 fps 800 600 59.944:3 1:1 No 800
SVGA 600p 29.97 fps 800 600 29.974:3 1:1 No 800
SVGA 600p 23.98 fps 800 600 23.984:3 1:1 No 800
SVGA 600p 60 fps 800 600 60.004:3 1:1 No 800
SVGA 600p 50 fps 800 600 50.004:3 1:1 No 800
SVGA 600p 30 fps 800 600 30.004:3 1:1 No 800
SVGA 600p 25 fps 800 600 25.004:3 1:1 No 800
SVGA 600p 24 fps 800 600 24.004:3 1:1 No 800
SVGA 600p 15 fps 800 600 15.004:3 1:1 No 800
WVGA 480p 59.94 fps 800 480 59.945:3 1:1 No 800
WVGA 480p 29.97 fps 800 480 29.975:3 1:1 No 800
WVGA 480p 23.98 fps 800 480 23.985:3 1:1 No 800
WVGA 480p 60 fps 800 480 60.005:3 1:1 No 800
WVGA 480p 50 fps 800 480 50.005:3 1:1 No 800
WVGA 480p 30 fps 800 480 30.005:3 1:1 No 800
WVGA 480p 25 fps 800 480 25.005:3 1:1 No 800
WVGA 480p 24 fps 800 480 24.005:3 1:1 No 800
WVGA 480p 15 fps 800 480 15.005:3 1:1 No 800
PAL SD SQ 576p 25 fps 768 576 25.004:3 1:1 No 768
WVGA 480p 59.94 fps 768 480 59.9416:101:1 No 768
WVGA 480p 29.97 fps 768 480 29.9716:101:1 No 768
WVGA 480p 23.98 fps 768 480 23.9816:101:1 No 768
WVGA 480p 60 fps 768 480 60.0016:101:1 No 768
WVGA 480p 50 fps 768 480 50.0016:101:1 No 768
WVGA 480p 30 fps 768 480 30.0016:101:1 No 768
WVGA 480p 25 fps 768 480 25.0016:101:1 No 768
WVGA 480p 24 fps 768 480 24.0016:101:1 No 768
WVGA 480p 15 fps 768 480 15.0016:101:1 No 768
HD Vertical 720p 59.94 fps 720 128059.949:16 1:1 No 720
HD Vertical 720p 29.97 fps 720 128029.979:16 1:1 No 720
HD Vertical 720p 23.98 fps 720 128023.989:16 1:1 No 720
HD Vertical 720p 60 fps 720 128060.009:16 1:1 No 720
HD Vertical 720p 50 fps 720 128050.009:16 1:1 No 720
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HD Vertical 720p 30 fps 720 128030.009:16 1:1 No 720
HD Vertical 720p 25 fps 720 128025.009:16 1:1 No 720
HD Vertical 720p 24 fps 720 128024.009:16 1:1 No 720
PAL SD Anamorphic 576p 50 fps 720 576 50.0016:9 64:45No 1024
PAL SD Anamorphic 576p 50 fps 720 576 50.004:3 16:15No 768
PAL SD Widescreen Anamorphic 576p 25 fps 720 576 25.0016:9 64:45No 1024
PAL SD Anamorphic 576p 25 fps 720 576 25.004:3 16:15No 768
PAL SD Widescreen Anamorphic 576i 25 fps 720 576 25.0016:9 64:45Yes 1024
PAL SD Anamorphic 576i 25 fps 720 576 25.004:3 16:15Yes 768
NTSC SD Anamorphic 486p 23.98 fps 720 486 23.9816:9 6:5 No 864
NTSC SD Anamorphic 486p 23.98 fps 720 486 23.984:3 9:10 No 648
NTSC SD Anamorphic 486i 29.97 fps 720 486 29.9716:9 6:5 Yes 864
NTSC SD Anamorphic 486i 29.97 fps 720 486 29.974:3 9:10 Yes 648
NTSC SD Anamorphic 480p 59.94 fps 720 480 59.9416:9 32:27No 853
NTSC SD Anamorphic 480p 59.94 fps 720 480 59.944:3 8:9 No 640
WVGA 480p 59.94 fps 720 480 59.943:2 1:1 No 720
NTSC SD Widescreen Anamorphic 480p 29.97 fps 720 480 29.9716:9 32:27No 853
NTSC SD Anamorphic 480p 29.97 fps 720 480 29.974:3 8:9 No 640
WVGA 480p 29.97 fps 720 480 29.973:2 1:1 No 720
NTSC SD Anamorphic 480p 23.98 fps 720 480 23.9816:9 32:27No 853
NTSC SD Anamorphic 480p 23.98 fps 720 480 23.984:3 8:9 No 640
WVGA 480p 23.98 fps 720 480 23.983:2 1:1 No 720
NTSC SD Anamorphic 480p 60 fps 720 480 60.0016:9 32:27No 853
NTSC SD Anamorphic 480p 60 fps 720 480 60.004:3 8:9 No 640
WVGA 480p 60 fps 720 480 60.003:2 1:1 No 720
NTSC SD Anamorphic 480p 50 fps 720 480 50.0016:9 32:27No 853
NTSC SD Anamorphic 480p 50 fps 720 480 50.004:3 8:9 No 640
WVGA 480p 50 fps 720 480 50.003:2 1:1 No 720
NTSC SD Anamorphic 480p 30 fps 720 480 30.0016:9 32:27No 853
NTSC SD Anamorphic 480p 30 fps 720 480 30.004:3 8:9 No 640
WVGA 480p 30 fps 720 480 30.003:2 1:1 No 720
NTSC SD Anamorphic 480p 25 fps 720 480 25.0016:9 32:27No 853
NTSC SD Anamorphic 480p 25 fps 720 480 25.004:3 8:9 No 640
WVGA 480p 25 fps 720 480 25.003:2 1:1 No 720
NTSC SD Anamorphic 480p 24 fps 720 480 24.0016:9 32:27No 853
NTSC SD Anamorphic 480p 24 fps 720 480 24.004:3 8:9 No 640
WVGA 480p 24 fps 720 480 24.003:2 1:1 No 720
WVGA 480p 15 fps 720 480 15.003:2 1:1 No 720
NTSC SD Anamorphic 480i 59.94 fps 720 480 59.9416:9 32:27Yes 853
NTSC SD Anamorphic 480i 59.94 fps 720 480 59.944:3 8:9 Yes 640
NTSC SD Widescreen Anamorphic 480i 29.97 fps 720 480 29.9716:9 32:27Yes 853
NTSC SD Anamorphic 480i 29.97 fps 720 480 29.974:3 8:9 Yes 640
NTSC SD Anamorphic 480i 23.98 fps 720 480 23.9816:9 32:27Yes 853
NTSC SD Anamorphic 480i 23.98 fps 720 480 23.984:3 8:9 Yes 640
NTSC SD Anamorphic 480i 60 fps 720 480 60.0016:9 32:27Yes 853
NTSC SD Anamorphic 480i 60 fps 720 480 60.004:3 8:9 Yes 640
NTSC SD Anamorphic 480i 30 fps 720 480 30.0016:9 32:27Yes 853
NTSC SD Anamorphic 480i 30 fps 720 480 30.004:3 8:9 Yes 640
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NTSC SD Anamorphic 480i 25 fps 720 480 25.0016:9 32:27Yes 853
NTSC SD Anamorphic 480i 25 fps 720 480 25.004:3 8:9 Yes 640
NTSC SD Anamorphic 480i 24 fps 720 480 24.0016:9 32:27Yes 853
NTSC SD Anamorphic 480i 24 fps 720 480 24.004:3 8:9 Yes 640
PAL SD 4CIF 4SIF Anamorphic 576p 29.97 fps 704 576 29.974:3 12:11No 768
PAL SD 4CIF 4SIF Anamorphic 576p 25 fps 704 576 25.004:3 12:11No 768
PAL SD 4CIF 4SIF Anamorphic 576p 15 fps 704 576 15.004:3 12:11No 768
PAL SD Anamorphic 576i 25 fps 704 576 25.0016:9 16:11Yes 1024
PAL SD Anamorphic 576i 25 fps 704 576 25.004:3 12:11Yes 768
NTSC SD Anamorphic 480p 59.94 fps 704 480 59.9416:9 40:33No 853
NTSC SD Anamorphic 480p 59.94 fps 704 480 59.944:3 10:11No 640
NTSC SD Anamorphic 480p 29.97 fps 704 480 29.9716:9 40:33No 853
NTSC SD 4SIF Anamorphic 480p 29.97 fps 704 480 29.974:3 10:11No 640
NTSC SD Anamorphic 480p 23.98 fps 704 480 23.9816:9 40:33No 853
NTSC SD Anamorphic 480p 23.98 fps 704 480 23.984:3 10:11No 640
NTSC SD Anamorphic 480p 60 fps 704 480 60.0016:9 40:33No 853
NTSC SD Anamorphic 480p 60 fps 704 480 60.004:3 10:11No 640
NTSC SD Anamorphic 480p 50 fps 704 480 50.0016:9 40:33No 853
NTSC SD Anamorphic 480p 50 fps 704 480 50.004:3 10:11No 640
NTSC SD Anamorphic 480p 30 fps 704 480 30.0016:9 40:33No 853
NTSC SD Anamorphic 480p 30 fps 704 480 30.004:3 10:11No 640
NTSC SD Anamorphic 480p 25 fps 704 480 25.0016:9 40:33No 853
NTSC SD 4SIF Anamorphic 480p 25 fps 704 480 25.004:3 10:11No 640
NTSC SD Anamorphic 480p 24 fps 704 480 24.0016:9 40:33No 853
NTSC SD Anamorphic 480p 24 fps 704 480 24.004:3 10:11No 640
NTSC SD 4SIF Anamorphic 480p 15 fps 704 480 15.004:3 10:11No 640
NTSC SD Anamorphic 480i 29.97 fps 704 480 29.9716:9 40:33Yes 853
NTSC SD 4SIF Anamorphic 480i 29.97 fps 704 480 29.974:3 10:11Yes 640
NTSC SD Anamorphic 480i 30 fps 704 480 30.0016:9 40:33Yes 853
NTSC SD Anamorphic 480i 30 fps 704 480 30.004:3 10:11Yes 640
NTSC SD Anamorphic 480i 25 fps 704 480 25.0016:9 40:33Yes 853
NTSC SD Anamorphic 480i 25 fps 704 480 25.004:3 10:11Yes 640
NTSC SD VGA 480p 59.94 fps 640 480 59.944:3 1:1 No 640
NTSC SD SQ VGA 480p 29.97 fps 640 480 29.974:3 1:1 No 640
NTSC SD VGA 480p 23.98 fps 640 480 23.984:3 1:1 No 640
NTSC SD VGA 480p 60 fps 640 480 60.004:3 1:1 No 640
NTSC SD VGA 480p 50 fps 640 480 50.004:3 1:1 No 640
NTSC SD VGA 480p 30 fps 640 480 30.004:3 1:1 No 640
NTSC SD VGA 480p 25 fps 640 480 25.004:3 1:1 No 640
NTSC SD VGA 480p 24 fps 640 480 24.004:3 1:1 No 640
VGA 480p 15 fps 640 480 15.004:3 1:1 No 640
NTSC SD 480i 29.97 fps 640 480 29.974:3 1:1 Yes 640
NTSC SD 480i 23.98 fps 640 480 23.984:3 1:1 Yes 640
NTSC SD 480i 30 fps 640 480 30.004:3 1:1 Yes 640
NTSC SD 480i 25 fps 640 480 25.004:3 1:1 Yes 640
NTSC SD 480i 24 fps 640 480 24.004:3 1:1 Yes 640
nHD 360p 59.94 fps 640 360 59.9416:9 1:1 No 640
nHD 360p 29.97 fps 640 360 29.9716:9 1:1 No 640
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nHD 360p 23.98 fps 640 360 23.9816:9 1:1 No 640
nHD 360p 60 fps 640 360 60.0016:9 1:1 No 640
nHD 360p 50 fps 640 360 50.0016:9 1:1 No 640
nHD 360p 30 fps 640 360 30.0016:9 1:1 No 640
nHD 360p 25 fps 640 360 25.0016:9 1:1 No 640
nHD 360p 24 fps 640 360 24.0016:9 1:1 No 640
PAL SD Anamorphic 576p 25 fps 544 576 25.0016:9 32:17No 1024
PAL SD Anamorphic 576p 25 fps 544 576 25.004:3 24:17No 768
PAL SD Anamorphic 576i 25 fps 544 576 25.0016:9 32:17Yes 1024
PAL SD Anamorphic 576i 25 fps 544 576 25.004:3 24:17Yes 768
NTSC SD 3/4 Anamorphic 480p 23.98 fps 544 480 23.984:3 20:17No 640
NTSC SD 3/4 Anamorphic 480p 25 fps 544 480 25.004:3 20:17No 640
NTSC SD 3/4 Anamorphic 480i 29.97 fps 544 480 29.974:3 20:17Yes 640
NTSC SD 3/4 Anamorphic 480i 25 fps 544 480 25.004:3 20:17Yes 640
NTSC SD 3/4 Anamorphic 480p 23.98 fps 528 480 23.984:3 40:33No 640
NTSC SD 3/4 Anamorphic 480p 25 fps 528 480 25.004:3 40:33No 640
NTSC SD 3/4 Anamorphic 480i 29.97 fps 528 480 29.974:3 40:33Yes 640
NTSC SD 3/4 Anamorphic 480i 25 fps 528 480 25.004:3 40:33Yes 640
PAL SD 1/4 Wide 288p 25 fps 512 288 25.0016:9 1:1 No 512
PAL SD Anamorphic 576p 25 fps 480 576 25.0016:9 32:15No 1024
PAL SD Anamorphic 576p 25 fps 480 576 25.004:3 8:5 No 768
PAL SD Anamorphic 576i 25 fps 480 576 25.0016:9 32:15Yes 1024
PAL SD Anamorphic 576i 25 fps 480 576 25.004:3 8:5 Yes 768
NTSC SD Anamorphic 480i 29.97 fps 480 480 29.9716:9 16:9 Yes 853
NTSC SD Anamorphic 480i 29.97 fps 480 480 29.974:3 4:3 Yes 640
NTSC SD Anamorphic 480i 23.98 fps 480 480 23.9816:9 16:9 Yes 853
NTSC SD Anamorphic 480i 23.98 fps 480 480 23.984:3 4:3 Yes 640
NTSC SD Anamorphic 480i 30 fps 480 480 30.004:3 4:3 Yes 640
HVGA 320p 59.94 fps 480 320 59.943:2 1:1 No 480
HVGA 320p 29.97 fps 480 320 29.973:2 1:1 No 480
HVGA 320p 23.98 fps 480 320 23.983:2 1:1 No 480
HVGA 320p 60 fps 480 320 60.003:2 1:1 No 480
HVGA 320p 50 fps 480 320 50.003:2 1:1 No 480
HVGA 320p 30 fps 480 320 30.003:2 1:1 No 480
HVGA 320p 25 fps 480 320 25.003:2 1:1 No 480
HVGA 320p 24 fps 480 320 24.003:2 1:1 No 480
HVGA 320p 15 fps 480 320 15.003:2 1:1 No 480
NTSC SD 1/4 Wide 240p 29.97 fps 427 240 29.9716:9 1:1 No 427
WQVGA 240p 59.94 fps 400 240 59.945:3 1:1 No 400
WQVGA 240p 29.97 fps 400 240 29.975:3 1:1 No 400
WQVGA 240p 23.98 fps 400 240 23.985:3 1:1 No 400
WQVGA 240p 60 fps 400 240 60.005:3 1:1 No 400
WQVGA 240p 50 fps 400 240 50.005:3 1:1 No 400
WQVGA 240p 30 fps 400 240 30.005:3 1:1 No 400
WQVGA 240p 25 fps 400 240 25.005:3 1:1 No 400
WQVGA 240p 24 fps 400 240 24.005:3 1:1 No 400
WQVGA 240p 15 fps 400 240 15.005:3 1:1 No 400
PAL SD 1/4 288p 25 fps 384 288 25.004:3 1:1 No 384

continues on next page
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Table 2 – continued from previous page
Profile Name WidthHeightFPSDARSARInter-

laced
SAR Adjusted
Width

WQVGA 240p 59.94 fps 384 240 59.9416:101:1 No 384
WQVGA 240p 29.97 fps 384 240 29.9716:101:1 No 384
WQVGA 240p 23.98 fps 384 240 23.9816:101:1 No 384
WQVGA 240p 60 fps 384 240 60.0016:101:1 No 384
WQVGA 240p 50 fps 384 240 50.0016:101:1 No 384
WQVGA 240p 30 fps 384 240 30.0016:101:1 No 384
WQVGA 240p 25 fps 384 240 25.0016:101:1 No 384
WQVGA 240p 24 fps 384 240 24.0016:101:1 No 384
WQVGA 240p 15 fps 384 240 15.0016:101:1 No 384
WQVGA 240p 59.94 fps 360 240 59.943:2 1:1 No 360
WQVGA 240p 29.97 fps 360 240 29.973:2 1:1 No 360
WQVGA 240p 23.98 fps 360 240 23.983:2 1:1 No 360
WQVGA 240p 60 fps 360 240 60.003:2 1:1 No 360
WQVGA 240p 50 fps 360 240 50.003:2 1:1 No 360
WQVGA 240p 30 fps 360 240 30.003:2 1:1 No 360
WQVGA 240p 25 fps 360 240 25.003:2 1:1 No 360
WQVGA 240p 24 fps 360 240 24.003:2 1:1 No 360
WQVGA 240p 15 fps 360 240 15.003:2 1:1 No 360
PAL SD Anamorphic 576p 25 fps 352 576 25.0016:9 32:11No 1024
PAL SD CVD Anamorphic 576p 25 fps 352 576 25.004:3 24:11No 768
PAL SD Anamorphic 576i 25 fps 352 576 25.0016:9 32:11Yes 1024
PAL SD CVD Anamorphic 576i 25 fps 352 576 25.004:3 24:11Yes 768
NTSC SD CVD Anamorphic 480p 29.97 fps 352 480 29.974:3 20:11No 640
NTSC SD 1/2 Anamorphic 480p 23.98 fps 352 480 23.984:3 20:11No 640
NTSC SD 1/2 Anamorphic 480p 25 fps 352 480 25.004:3 20:11No 640
NTSC SD CVD 1/2 Anamorphic 480i 29.97 fps 352 480 29.974:3 20:11Yes 640
NTSC SD 1/2 Anamorphic 480i 25 fps 352 480 25.004:3 20:11Yes 640
PAL SD CIF SIF Anamorphic 288p 29.97 fps 352 288 29.974:3 12:11No 384
PAL SD Anamorphic 288p 25 fps 352 288 25.0016:9 16:11No 512
PAL SD CIF SIF VCD Anamorphic 288p 25 fps 352 288 25.004:3 12:11No 384
PAL SD CIF SIF Anamorphic 288p 15 fps 352 288 15.004:3 12:11No 384
PAL SD Anamorphic 288i 25 fps 352 288 25.0016:9 16:11Yes 512
PAL SD CIF Anamorphic 288i 25 fps 352 288 25.004:3 12:11Yes 384
NTSC SD SIF VCD Anamorphic 240p 29.97 fps 352 240 29.974:3 10:11No 320
NTSC SD SIF Anamorphic 240p 23.98 fps 352 240 23.984:3 10:11No 320
NTSC SD SIF Anamorphic 240p 25 fps 352 240 25.004:3 10:11No 320
NTSC SD SIF Anamorphic 240p 15 fps 352 240 15.004:3 10:11No 320
NTSC SD SIF Anamorphic 240i 29.97 fps 352 240 29.974:3 10:11Yes 320
QVGA 240p 59.94 fps 320 240 59.944:3 1:1 No 320
NTSC SD 1/4 QVGA 240p 29.97 fps 320 240 29.974:3 1:1 No 320
QVGA 240p 23.98 fps 320 240 23.984:3 1:1 No 320
QVGA 240p 60 fps 320 240 60.004:3 1:1 No 320
QVGA 240p 50 fps 320 240 50.004:3 1:1 No 320
QVGA 240p 30 fps 320 240 30.004:3 1:1 No 320
QVGA 240p 25 fps 320 240 25.004:3 1:1 No 320
QVGA 240p 24 fps 320 240 24.004:3 1:1 No 320
QVGA 240p 15 fps 320 240 15.004:3 1:1 No 320
HQVGA 160p 59.94 fps 256 160 59.9416:101:1 No 256

continues on next page
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Table 2 – continued from previous page
Profile Name WidthHeightFPSDARSARInter-

laced
SAR Adjusted
Width

HQVGA 160p 29.97 fps 256 160 29.9716:101:1 No 256
HQVGA 160p 23.98 fps 256 160 23.9816:101:1 No 256
HQVGA 160p 60 fps 256 160 60.0016:101:1 No 256
HQVGA 160p 50 fps 256 160 50.0016:101:1 No 256
HQVGA 160p 30 fps 256 160 30.0016:101:1 No 256
HQVGA 160p 25 fps 256 160 25.0016:101:1 No 256
HQVGA 160p 24 fps 256 160 24.0016:101:1 No 256
HQVGA 160p 15 fps 256 160 15.0016:101:1 No 256
HQVGA 160p 59.94 fps 240 160 59.943:2 1:1 No 240
HQVGA 160p 29.97 fps 240 160 29.973:2 1:1 No 240
HQVGA 160p 23.98 fps 240 160 23.983:2 1:1 No 240
HQVGA 160p 60 fps 240 160 60.003:2 1:1 No 240
HQVGA 160p 50 fps 240 160 50.003:2 1:1 No 240
HQVGA 160p 30 fps 240 160 30.003:2 1:1 No 240
HQVGA 160p 25 fps 240 160 25.003:2 1:1 No 240
HQVGA 160p 24 fps 240 160 24.003:2 1:1 No 240
HQVGA 160p 15 fps 240 160 15.003:2 1:1 No 240
PAL SD QCIF Anamorphic 144p 29.97 fps 176 144 29.974:3 12:11No 192
PAL SD QCIF Anamorphic 144p 25 fps 176 144 25.004:3 12:11No 192
PAL SD QCIF Anamorphic 144p 15 fps 176 144 15.004:3 12:11No 192
NTSC SD SIF 1/2 Anamorphic 120p 23.98 fps 176 120 23.984:3 10:11No 160
NTSC SD SIF 1/2 Anamorphic 120p 25 fps 176 120 25.004:3 10:11No 160
QQVGA 120p 59.94 fps 160 120 59.944:3 1:1 No 160
QQVGA 120p 29.97 fps 160 120 29.974:3 1:1 No 160
QQVGA 120p 23.98 fps 160 120 23.984:3 1:1 No 160
QQVGA 120p 60 fps 160 120 60.004:3 1:1 No 160
QQVGA 120p 50 fps 160 120 50.004:3 1:1 No 160
QQVGA 120p 30 fps 160 120 30.004:3 1:1 No 160
QQVGA 120p 25 fps 160 120 25.004:3 1:1 No 160
QQVGA 120p 24 fps 160 120 24.004:3 1:1 No 160
QQVGA 120p 15 fps 160 120 15.004:3 1:1 No 160
NTSC SD SQ CIF 96p 29.97 fps 128 96 29.974:3 1:1 No 128
NTSC SD SQ CIF 96p 25 fps 128 96 25.004:3 1:1 No 128
NTSC SD SQ CIF 96p 15 fps 128 96 15.004:3 1:1 No 128

1.14 Import & Export

Video editing projects (including tracks, clips, and keyframes) can be imported and exported from OpenShot Video
Editor in widely supported formats (EDL: Edit Decision Lists, and XML: Final Cut Pro format). For example, if you
start editing a video in a different program (Adobe Premier, Final Cut Pro, etc. . . ), but later need to move all your edits
to OpenShot (or vice versa).
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1.14.1 EDL (Edit Decision Lists)

The following features are supported when importing and exporting an EDL file with OpenShot.

EDL Option Name Description
EDL Format CMX-3600 (a very widely supported variation)
Single Track Only a single track can be imported at a time (this is a limitation of the EDL format)
Tape Name Only AX and BL tape names are currently supported in OpenShot
Edits (V and A) Only edits are currently supported (transitions are not yet supported)
Opacity Opacity keyframes are supported
Audio Levels Volume keyframes are supported

Example EDL Output

Listing 5: Example EDL format supported by OpenShot:

TITLE: Clips - TRACK 5
FCM: NON-DROP FRAME

001 BL V C 00:00:00:01 00:00:03:17 00:00:00:01 00:00:03:17
001 AX V C 00:00:00:01 00:00:10:01 00:00:03:17 00:00:13:17
* FROM CLIP NAME: Intro.png

002 BL V C 00:00:00:01 00:00:05:09 00:00:13:17 00:00:18:25
002 AX V C 00:00:00:01 00:00:10:01 00:00:18:25 00:00:28:25
* FROM CLIP NAME: FileName.mp4
* OPACITY LEVEL AT 00:00:00:01 IS 0.00% (REEL AX)
* OPACITY LEVEL AT 00:00:01:01 IS 100.00% (REEL AX)
* OPACITY LEVEL AT 00:00:09:01 IS 100.00% (REEL AX)
* OPACITY LEVEL AT 00:00:10:01 IS 0.00% (REEL AX)

003 BL V C 00:00:00:01 00:00:33:15 00:00:28:25 00:01:02:09
003 AX V C 00:00:14:25 00:00:34:29 00:01:02:09 00:01:22:13
003 AX A C 00:00:14:25 00:00:34:29 00:01:02:09 00:01:22:13
* FROM CLIP NAME: FileName2.mp4

004 BL V C 00:00:00:01 00:00:26:25 00:01:22:13 00:01:49:07
004 AX A C 00:00:00:01 00:02:20:01 00:01:49:07 00:04:09:07
* FROM CLIP NAME: Music.wav
* AUDIO LEVEL AT 00:00:00:01 IS -99.00 DB (REEL AX A1)
* AUDIO LEVEL AT 00:00:03:01 IS 0.00 DB (REEL AX A1)
* AUDIO LEVEL AT 00:02:17:01 IS 0.00 DB (REEL AX A1)
* AUDIO LEVEL AT 00:02:20:01 IS -99.00 DB (REEL AX A1)
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1.14.2 XML (Final Cut Pro format)

The following features are supported when importing and exporting an XML file with OpenShot. This XML format
is supported in many video editors (not just Final Cut Pro). In fact, most commercial video editors have some support
for importing and exporting this same XML format.

XML Option Name Description
XML Format Final Cut Pro format (but most commercial video editors also support this format)
All Tracks All video and audio tracks are supported
Edits All clips on all tracks are supported (video, image, and audio files). Transitions are not

yet supported.
Opacity Opacity keyframes are supported
Audio Levels Volume keyframes are supported

Example XML Output (tree view)

1.14. Import & Export 123



OpenShot Video Editor Documentation, Release 3.1.1

1.15 Preferences

The Preferences window contains many important settings and configuration options for OpenShot. They can be found
in the top menu under Edit→Preferences. Many settings will require OpenShot to be restarted after your changes are
applied.

NOTE: Some features such as Animated Titles and external SVG editing require setting the paths for Blender and
Inkscape under the General tab. And if you notice audio playback issues, such as audio drift, you may need to adjust
the audio settings under the Preview tab.

1.15.1 General

The General tab of the Preferences window allows you to modify the settings that apply to OpenShot as a whole.

Setting Default Description
Language Default Choose your preferred language for OpenShot menus and win-

dows
Default Theme Human-

ity:Dark
Choose your theme for OpenShot, either Light, Dark or None

Image Length (seconds) 10.00 How long the image displays on the screen when added to the
timeline

Volume 75.00 The percentage of the volume of the clip when added to the time-
line

Blender Command (path) <blank> The path to the binary for Blender (version 2.8+)
Advanced Title Editor (path) <blank> The path to the binary for Inkscape
Show Export Dialog when
Finished

<checked> Displays the Export Video windows after the export is finished
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1.15.2 Preview

The Preview tab of the Preferences window allows you to set a Default Video Profile for your project, if you have a
preference for a specific editing profile. More about Profiles. Also, you can adjust the real-time preview audio settings,
for example, which audio device and sample rate to use.

Setting Default Description
Default Video Profile HD 720P 30

fps
Select the profile for Preview and Export defaults

Playback Audio Device Default
Default Audio Sample Rate 44100
Default Audio Channels Stereo (2

Channel)
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1.15.3 Autosave

Autosave is a saving function in OpenShot which automatically saves the current changes to your project after a specific
number of minutes, helping to reduce the risk or impact of data loss in case of a crash, freeze or user error.

Recovery

Before each save, a copy of the current project is created in a recovery folder, to further reduce the risk of data loss. The
recovery folder is located at ~/.openshot_qt/recovery/ or C:\Users\USERNAME\.openshot_qt\recovery. If
you need to recover a corrupt or broken *.osp project file, please find the most recent copy in the recovery folder, and
copy/paste the file in your original project folder location (i.e. the folder that contains your broken project), and then
open this recovered project file in OpenShot. Many versions of each project are stored in the recovery folder, and if
you still have issues with the recovered *.osp file, you can repeat this process with older versions contained in the
recovery folder.
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1.15.4 Cache

Cache settings can be adjusted to make real-time playback faster or less CPU intensive. The cache is used to store
image and audio data for each frame of video requested. The more frames that are cached, the smoother the real-time
playback will be. However, the more that needs to be cached requires more CPU to generate the cache. There is a
balance, and the default settings provide a generally sane set of cache values, which should allow most computers to
playback video and audio smoothly. See Playback.
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Setting Description
Cache Mode Choose between Memory or Disk caching (memory caching is preferred). Disk

caching writes image data to the hard disk for later retrieving, and works best
with an SSD.

Cache Limit (MB) How many MB are set aside for cache related data. Larger numbers are not
always better, since it takes more CPU to generate more frames to fill the cache.

Image Format (Disk Only) Image format to store disk cache image data
Scale Factor (Disk Only) Percentage (0.1 to 1.0) to reduce the size of disk based image files stored in

the disk cache. Smaller numbers make writing and reading cached image files
faster.

Image Quality (Disk Only) Quality of the image files used in disk cache. The higher compression can cause
more slowness, but results in smaller file sizes.

Cache Pre-roll: Min Frames: Minimum # of frames that must be cached before playback begins. The larger
the #, the larger the wait before playback begins.

Cache Pre-roll: Max Frames: Maximum # of frames that can be cached during playback (in front of the play-
head). The larger the #, the more CPU is required to cache ahead - vs display
the already cached frames.

Cache Ahead (Percent): Between 0.0 and 1.0. This represents how much % we cache ahead of the
playhead. For example, 0.5 would cache 50% behind and 50% ahead of the
playhead. 0.8 would cache 20% behind and 80% ahead of the playhead.

Cache Max Frames: This is an override on the total allowed frames that can be cached by our caching
thread. It is defaulted to 600 frames, but even if you give a huge amount of
RAM to OpenShot’s cache size, this will override the max # of frames cached.
The reason is. . . sometimes when the preview window is very small, and the
cache size is set very high, OpenShot might calculate that we can cache 30,000
frames, or something silly which will take a huge amount of CPU, lagging
the system. This setting is designed to clamp the upper limit of the cache to
something reasonable. . . even on systems that give OpenShot huge amounts of
RAM to work with.
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1.15.5 Debug

Here you can modify how much data should be logged. Normally, Debug Mode (verbose) is off. The default port is
5556. If you want to help improve OpenShot you can enable Send Anonymous Metrics and Errors.
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1.15.6 Performance

Please keep in mind that GPU hardware acceleration is experimental at the moment. OpenShot supports both decoding
and encoding acceleration. For more information take a look at our Github HW-ACCEL Doc. NOTE: On systems with
older graphics cards, hardware acceleration may not always be faster than CPU encoding.
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1.15.7 Keyboard

This is where hotkeys can be seen and re-assigned, as described under Keyboard Shortcuts.
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1.15.8 Location

Default file path locations for saving/opening projects, importing files, and exporting videos can be configured here.
This can save you time by defaulting the open/save file dialogs to the most appropriate starting folder (options described
below).

Setting Description
File Import Default folder to choose when importing a file
Save or Open Project Default folder to choose when saving or opening a project file
Video Export Default folder to choose when exporting a video

Values Description
Recent Folder The last folder used for this same operation. Project folders, Import folders, and Export

folders are tracked separately.
Project Folder The current project folder (or the user’s home folder, if the project is not yet saved)

1.15.9 Reset (Default Values)

To reset all preferences to their default values, please delete the openshot.settings file and re-launch OpenShot.
The settings file can be located at this path: ~/.openshot_qt/openshot.settings or C:\Users\USERNAME\
.openshot_qt\openshot.settings. When OpenShot is re-launched, it will create the missing openshot.
settings file with default values.

Optionally, you can delete the entire .openshot_qt/ folder and re-launch OpenShot. However, please make a backup
of any customized folders: emojis, presets, profiles, recovery, title_templates, transitions, or yolo. For example,
your /recovery/ sub-folder contains backup copies of all your existing projects (*.osp files).
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Deleting the .openshot_qt/ folder is the quickest method to restore OpenShot preferences and settings to their Default
values (i.e. also called a clean install). When OpenShot is re-launched, it will create any missing folders (i.e. .
openshot_qt/) and settings files. See our step-by-step guide for more information about clean installs of OpenShot.

1.16 Playback

The preview window is where video & audio playback takes place in OpenShot Video Editor. The preview window
utilizes real-time video rendering, caching, re-sampling, and image scaling. This is the primary area for watching back
(and listening to) your edits, giving you the feedback needed to make adjustments. It is also one of the most costly
operations to your CPU, and requires a modern computer and some reasonable assumptions and factors (listed below).

1.16.1 Real-Time Preview

Many factors affect how smoothly the real-time video preview can playback on your computer. This requires a fast,
modern multi-threaded CPU, lots of RAM (memory), and a modern GPU. We have listed many of the important factors
below.
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Factor Description
CPU If your CPU is too slow or has too few cores, you will likely experience a slow, choppy

preview. We recommend installing OpenShot on fairly modern computer. See System
Requirements for more details on the hardware requirements for OpenShot Video Editor.

Memory If your available RAM memory is too limited, you will likely see huge drops in real-time
performance, and your entire system will lag. We recommend installing additional RAM
in your computer, if possible. See System Requirements.

Cache Your cache settings in the OpenShot Preferences are very important for determining how
many frames to processes in advance. A value too low or too high can cause lag during
the real-time video preview. The cache is also related to the available RAM. The higher
the cache values, the more RAM and CPU is needed. We recommend experimenting with
the Cache Preferences in OpenShot if you are experiencing issues with smooth playback.
See Cache.

Preview Size The height x width of your preview dock (widget) is very important for smooth real-time
previews. The larger the window size, the more pixels must be rendered per frame, and
the more CPU and RAM are required. It is recommended to keep reducing the preview
window size until you achieve smooth video playback. On a slower computer, the preview
window size might need to be very small for real-time previews (i.e. 320 x 240).

Profile Your project profile determines which size (width x height) and frame rate (FPS) are used
during both playback and exporting. For example, if you are using a FHD 1920x1080
sized profile, you can also choose a smaller profile with the same aspect ratio (16x9 in
this example), to improve the preview speed on slower computers. See Profiles for more
information on available profiles.

FPS (Frame Rate) The FPS of your project is also very important, and a large factor for smooth video play-
back. For example, a 60 FPS video must render twice the number of frames, compared to
a 30 FPS video. If you are experiencing slow downs in real-time performance, it can be
helpful to reduce your project’s FPS to a lower value, such as 30 or 24.

Matching Rates It is very important to match your source assets FPS and Sample Rate with your Project
FPS and Project sample rate. If either rate does not match exactly, it requires lots of addi-
tional CPU and RAM for OpenShot to normalize the mismatching rates. This can lead to
audio pops, mis-alignments, duplicate frames, and extra lag in the real-time video preview.
You can right-click a file and choose File Properties, to inspect the source asset rates, and
ensure they match your Project settings (shown at the top of OpenShot). See Properties.

Source Assets For example, if you are editing 4K 60 FPS source assets, this is likely going to put a strain
on your system. A common solution is using another tool (such as FFmpeg) to create a
copy (or proxy) of all your source assets, at a lower resolution (and maybe even a lower
FPS). It is recommended to keep these proxy video files in their own folder, separate from
the original video files. Once you have completed your video editing with the proxy files,
simply copy/paste your *.osp project file back into the original folder, and export the higher
quality, original files.

Audio Device If you are still having issues with audio lag or sync, please verify you are using the correct
Audio Device for playback (in the OpenShot Preferences). See Preview. Also, verify your
default audio device (on your operating system) is using the same sample rate. On certain
operating systems (such as Windows), mismatching sample rates can cause severe audio /
video sync problems. Be sure to restart OpenShot after changing the audio device.
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1.16.2 Audio Troubleshooting

If you are still experiencing audio related issues, and the above real-time playback factors did not resolve your issue,
here are some additional troubleshooting steps you can take.

Step Description
Latest Daily Build Verify you are running the latest daily build of OpenShot: https://www.openshot.org/

download#daily
Clean Install See Reset (Default Values) for a clean install
Audio Device Check that the Playback Audio Device is set correctly for your sound output under Pref-

erences in the Preview tab. Restart OpenShot after changing the settings. You can also
try a different audio device (USB, audio over HDMI from the video card, etc.) to rule
out other audio issues. Disable automatic sound suppression for voice calls during micro-
phone activity, and disable Audio Enhancements under the advanced settings tab of your
audio device (not all audio devices have these settings). See Preview.

Sample Rate Ensure that the Default Audio Sample Rate and Default Audio Channels on the Preview
tab of the Preferences window match your hardware. You can also check these settings in
the operating system control panel (i.e. Windows Sound Control Panel). See Preview.

Volume Ensure that the volume does not exceed 100% on overlapping clips (such as an audio track
combined with a video track). Lower the volume on individual clips if needed. See Volume
Mixing.

Headphones If you’re using headphones, plug them in before starting OpenShot. Launching Open-
Shot with no speakers, headphones, or valid audio playback device can cause OpenShot
to freeze during playback.

OS Updates Update your operating system and any pending security updates. Some audio issues, es-
pecially audio device specific issues, can be resolved with an operating system update.

1.17 Developers

If you are a programmer (or want to become a programmer), and are interested in developing new features, fixing bugs,
or improving the user interface for OpenShot, the following sections will explain how to get started and get involved!

1.17.1 The Big Picture

OpenShot Video Editor has 3 main components, a Python & PyQt user interface (openshot-qt), a C++ audio library
(libopenshot-audio) and a C++ video library (libopenshot). If you are not familiar with Python, PyQt, or C++, those
would be great topics to research and learn more about at this point.

However, many bugs can be fixed and new features added with only Python knowledge, since the C++ components
are not involved in the user interface at all. Python is an amazing language, and is super fun to learn, and is the only
prerequisite skill needed to become an OpenShot developer!

Warning: The instructions that follow are for Ubuntu Linux, which is the easiest environment to configure for
OpenShot development. If you are using another OS, I suggest running a virtual machine with Ubuntu LTS before
continuing any further.

If you must use a Windows or Mac system for development, start by referring to the build notes in the libopenshot
wiki. Building the library with all of its dependencies is the most challenging part of the process.

• Windows Build Instructions
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• Mac Build Instructions

1.17.2 Getting the Latest Source Code

Before we can fix any bugs or add any features, we need to get the source code onto your computer.

Use git to clone our 3 repositories:

git clone https://github.com/OpenShot/libopenshot-audio.git
git clone https://github.com/OpenShot/libopenshot.git
git clone https://github.com/OpenShot/openshot-qt.git

1.17.3 Configuring your Development Environment

In order to actually compile or run OpenShot, we need to install some dependencies on your system. The easiest way
to accomplish this is with our Daily PPA. A PPA is an unofficial Ubuntu repository, which has our software packages
available to download and install.

sudo add-apt-repository ppa:openshot.developers/libopenshot-daily
sudo apt-get update
sudo apt-get install openshot-qt \

cmake \
libx11-dev \
libasound2-dev \
libavcodec-dev \
libavdevice-dev \
libavfilter-dev \
libavformat-dev \
libavresample-dev \
libavutil-dev \
libfdk-aac-dev \
libfreetype6-dev \
libjsoncpp-dev \
libmagick++-dev \
libopenshot-audio-dev \
libprotobuf-dev \
libqt5svg5-dev \
libswscale-dev \
libunittest++-dev \
libxcursor-dev \
libxinerama-dev \
libxrandr-dev \
libzmq3-dev \
pkg-config \
python3-dev \
protobuf-compiler \
qtbase5-dev \
libqt5svg5-dev \
libxcb-xfixes0-dev \
qtmultimedia5-dev \
swig
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At this point, you should have all 3 OpenShot components source code cloned into local folders, the OpenShot daily
PPA installed, and all of the required development and runtime dependencies installed. This is a great start, and we are
now ready to start compiling some code!

1.17.4 libopenshot-audio (Build Instructions)

This library is required for audio playback and audio effects. It is based on the JUCE audio framework. Here are the
commands to build it:

cd libopenshot-audio
mkdir build
cd build
cmake -DCMAKE_INSTALL_PREFIX=dist ..
make
make install

Essentially, we are switching to the libopenshot-audio/build folder, then running cmake .. on the parent folder.
This finds dependencies and creates all the needed Makefiles used to compile this library. Then make uses those Make-
files to compile this library, and make install installs them in the location we specified. If CMAKE_INSTALL_PREFIX
isn’t set, the files will install to /usr/local/ (by default) and make install will require administrative privileges to
run.

1.17.5 libopenshot (Build Instructions)

This library is required for video decoding, encoding, animation, and just about everything else. It does all the heavy
lifting of video editing and video playback. Here are the commands to build it:

cd libopenshot
mkdir build
cd build
cmake -DLIBOPENSHOT_AUDIO_DIR=../../libopenshot-audio/build/dist ..
make

Essentially, we are switching to the libopenshot/build folder, then running cmake .. on the parent folder. This
finds dependencies and creates all the needed Makefiles used to compile this library. Then make uses those Makefiles to
compile this library. Because we provided the location of our compiled libopenshot-audio installation, that version
of the library will be used instead of the system version (if any).

We don’t install our libopenshot after building, because we don’t need to. For testing purposes, we can tell OpenShot
to use libopenshot right from our build directory.

1.17.6 openshot-qt (Launch Instructions)

This is our main PyQt Python application. Because it is written in Python, it does not require any compiling to run. To
launch OpenShot from the source code with our newly-built libopenshot-audio and libopenshot libraries, use
the following commands:

cd openshot-qt
PYTHONPATH=../libopenshot/build/src/bindings/python
python3 src/launch.py
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This should launch the OpenShot user interface. Any changes you have made to the source code files (*.py Python
files, *.ui PyQt UI files, etc. . . ) will be included. This requires the libopenshot-audio and libopenshot libraries,
and if anything went wrong with the steps above, OpenShot will likely not launch.

If OpenShot launches at this point, congratulations! You now have a working local version of OpenShot, which is
running off your local source code. Try making some changes to the source code and re-launch OpenShot. . . you
should now see your changes!

1.17.7 GitHub Issues

Now that you have successfully compiled and launched OpenShot Video Editor from source code, be sure to check out
our list of bug reports on GitHub: OpenShot Issues. Also, you are encouraged to fill out our quick contributor form
and introduce yourself!

1.17.8 Share your Changes

Once you have fixed a bug or added an amazing new feature, be sure to share it with the OpenShot team. Ideally, we
can merge this into our main source code branch. The easiest way to share your changes is by creating a fork of our
repo, pushing your changes back to GitHub, and creating a Pull Request. A Pull Request lets the OpenShot team know
you have changes ready to be merged. Then we can review things, give feedback, and hopefully merge your changes
into the main branch.

1.18 Contributing

Want to help improve OpenShot (and make some friends in the process)? Please consider joining our open-source team
by filling out this quick contributor form and introduce yourself! All volunteers are welcome, regardless of skills or
skill level. Let’s build something amazing!

1.18.1 How to Contribute

There are many different ways to help and support OpenShot, including:

• Testing

• Translations

• Documentation

• Customer Service

• Social Media / Marketing

• Software Development

• Art / Design / UI

• User Community

• Donations

All of these areas are equally important, so we would love to know which ones appeal to you the most. Please take a
moment and fill-out our quick contributor form.
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1.18.2 Did you find a bug?

Please use our step-by-step bug reporting page: https://openshot.org/issues/new/ to troubleshoot a potential new bug.
This guide will instruct you on how to delete you log files, test with the latest daily build, and search for duplicate bug
reports (in case someone else has already reported this same issue). At the end of the guide, it will help you create a
detailed and useful bug report for our development team and volunteers.

1.18.3 Software Developers

OpenShot uses GitHub to manage issues and source code: https://github.com/OpenShot. Please read our guide on
Becoming a Developer for a step-by-step guide on compiling OpenShot and making your first pull request on GitHub.

1.18.4 Made with Love

OpenShot Video Editor is a volunteer effort and a labor of love. Please be patient with any issues you find, and feel
free to get involved and help us fix them!

Thank you for your support!
– OpenShot Team

1.19 Learn More

We are working hard to expand this user guide and to improve OpenShot Video Editor, but if you are stuck and don’t
know where to turn, OpenShot has several sources for additional information.

1. OpenShot has several YouTube Tutorials available to help you learn more.

2. OpenShot has a Reddit User Community dedicated to users helping users, answering questions, and discussing
video editing and OpenShot topics.

3. If you would like to help improve this User Guide, view source on GitHub.

4. If you have discovered a new bug, please Report a Bug.

5. If you need professional support, you can open a ticket by sending an message to support@openshot.org or
Schedule a call.

1.20 Glossary

There is much technical terminology in today’s fast-moving media-centric world. If you find yourself wondering what
a video production term or an acronym means, you are certainly not alone. Like most industries, video production has
a language all its own. Here is a list of terms commonly found in video editing. Becoming familiar with these terms
only makes your job easier.
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1.20.1 Definitions

These definitions are a work-in-progress. Please let us know if you need a term defined by contacting sup-
port@openshot.org.

-A- -B- -C- -D- -E- -F- -G- -H- -I- -J- -K- -L- -M- -N- -O- -P- -Q- -R- -S- -T- -U- -V- -W- -X- -Y- -Z-

-A-

A-Roll:
The Principal video that is usually someone speaking.

Aliasing:
The undesirable jagged or stair-stepped appearance of angled lines in an image, graphic, or text.

Alpha:
Alpha blending is a convex combination of two colors allowing for transparency effects in computer graphics.
The value of alpha in the color code ranges from 0.0 to 1.0, where 0.0 represents a fully transparent color, and
1.0 represents a fully opaque color.

Alpha Channel:
An alpha channel is a channel in an image or movie clip that controls the opacity region.
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Ambient Noise:
Ambient noise is background noise specific to the shooting location.

Animation:
The technique of making inanimate objects or drawings appear to move in motion pictures or computer graphics.

Anti-Aliasing:
Anti-aliasing is a process for smoothing jagged lines in an image. Anti-aliasing can also mean a method of
filtering out erroneous frequencies in an audio signal.

Artifact:
An artifact is undesired data in an image because of digital processing.

Aspect Ratio:
The ratio of width to height in a flat surface or 2-dimensional abstract construction, such as an image, video,
character, or pixel. The standard ratios for NTSC SD videos are 4:3 (or 1.33:1) and HD 16:9 (or 1.77:1). The
most common aspect ratios for motion pictures are 1.85:1 and 2.35:1.

ATSC:
ATSC is a digital broadcast standard that replaced the older analog NTSC standard. The standard covers both
standard and high-definition formats.

Audio Sample Rate:
The number of samples taken per second to reproduce audio digitally. The higher the sample rate, the higher the
quality of the digital audio. A rate of 44,100 samples per second produces CD-quality audio and captures the
range of human hearing.

-B-

B-roll:
B-roll is supplemental footage that provides supporting details and greater flexibility when editing video. Com-
mon examples include the footage used to cut away from an interview or news report to help tell the story.

Bit:
The elementary unit for digital storage. A BIT can be either a 1 (one) or a 0 (zero).

Bit Depth:
In digital graphics and video, bit depth indicates the number of colors an image can display. A high-contrast (no
gray tones) black and white image is 1bit, meaning it can be off or on, black or white. As bit depth increases,
more colors become available. 24-bit color allows for displays of millions of colors. Similarly, in digital audio,
bit depth indicates the number of bits per sample. The higher the number, the better the sound quality.

Bitrate:
The frequency at which bits (binary digits) pass a given physical or metaphorical point, measured in bps (bits
per second). For every second in the video, the Bit Rate, or Data Rate, is the amount of data used each second.
The bitrate, in Kilobits per second, can be variable or constant.

Blue Screen:
A blue screen is a blue background that the subject stands in front of that the computer later replaces with another
background in post-production. See also blue screen compositing and green screen.

Blue Screen Compositing:
The process of making all blue elements in an image transparent and placing a different background underneath.
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-C-

Capture:
The process of transferring source video from a camcorder or tape deck to a computer. If the source video is
analog, the capture process converts the video to digital.

Channel:
A channel is one of several grayscale components used to make up a color image. Red, green, and blue channels
make up RGB images, with an optional alpha channel for transparency.

Chromakey:
Chromakey is a method of creating transparency in a video source by selecting a specific “key color” to create
an alpha matte. It is frequently used on news programs to display weather graphics behind talent and for visual
effects compositing.

Clip:
A digitized or captured portion of video, audio, or both. Clips are media files added to the Timeline, usually part
of a more extensive recording.

Codec:
Codec is a video compression technology used to compress data in a video file. Codec stands for “Compression
Decompression.” An example of a popular codec is H.264.

Color Correction:
The process of altering the color of a video, especially one shot under less than ideal conditions, such as low
light.

Compositing:
Construction of a composite image by combining multiple images and other elements.

Coverage:
Coverage is the process of shooting additional footage and camera angles to cover the action in the scene. Cov-
erage is so that the editor has a more excellent range of choices when the film reaches the post-production stage.

Compression:
The process of reducing data, such as in an audio or video file, into a form that requires less space.

Crop Factor:
Crop factor is a number (typically from 1.3-2.0) that represents the ratio of a sensor’s imaging area to that of a
full-frame sensor. Try multiplying the focal length of your lens by your camera sensor’s crop factor. It gives you
the focal length for the lens/sensor combination.

Crawl:
Crawl is a text effect where the text moves right-to-left (in the English-speaking world).

Cross-fade:
A cross-fade is a simultaneous fade-in of one audio or video source as another fades out so that they overlap
temporarily. Also called a dissolve.

Cut:
A cut is an instantaneous change from one shot to another.

Cut-in (Insert Shot):
It is a type of shot that most often shows the objects the subject is in contact with or manipulating. Cut-in shots
are correspondingly helpful to b-roll because they stray from the subject for a short time.

Cutting on Action:
Cutting on action is a technique used to create a more interesting scene. The concept is simple. . . when you cut
in the middle of an action, it will appear less jarring and more visual interesting.
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-D-

Data Rate:
The amount of data moved over time (for example, 10 MB per second). Often used to describe a hard drive’s
ability to retrieve and deliver information.

Denominator:
The number or expression below the line in a fraction (such as 2 in ½).

Digital Video:
Digital video is an electronic representation of moving visual images (video) in the form of encoded digital data.
In contrast, analog video represents moving visual images with analog signals. Digital video comprises a series
of digital images displayed in rapid succession.

Digitize:
To convert analog video or audio to digital form.

Dissolve:
Dissolve is an image transition effect where one picture gradually disappears as another appears. Also called a
cross-fade.

-E-

Editing:
Editing is the process or result of selectively sequencing video and audio clips into a new video file. Typically
involves reviewing raw footage and transferring desired segments from source footage into a new predetermined
sequence.

Effect:
Synthetic sounds and animations created in the digital domain applied to a clip to change a specific parameter of
video or audio. Examples: the color of a visual element or the reverb on an audio track.

Encode:
To merge the individual video signals (for example, red, green, and blue) into a combined signal, or to convert a
video file to a different format using a codec.

Export:
Export refers to the process of assembling your edited video project into a single file that then plays back on its
own, shared, or uploaded.

-F-

Fade:
A fade is the gradual diminishing or heightening of visual or audio intensity. Usage: fade-out, fade to black,
fade-in, or fade up from black.

Fade-in:
1.(n.) a shot that begins in total darkness and gradually lightens to full brightness. 2. (v.) To gradually bring
sound from inaudibility to the required volume.

Fade-out:
1.(n.) a shot that begins in full brightness and gradually dims to total darkness. 2. (v.) To gradually bring sound
from the required volume to inaudibility.

Filter:
A video filter is a software component that performs some operation on a multimedia stream. Multiple filters
used in a chain, known as a filter graph, are the process in which each filter receives input from its upstream filter.
The filter graph processes the input and outputs the processed video to its downstream filter.
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Final Cut:
The final video production, assembled from high-quality clips, and ready for export to the selected delivery
media.

Finishing:
The stage that brings together all assets of a piece. Your output from this stage is your master/sub-master.

Footage:
Derived from having feet of film, this is almost synonymous with video clips.

Frame:
In filmmaking, video production, animation, and related fields, a frame is one of the many still images which
compose the complete moving picture.

Frames Per Second (fps):
The number of frames played every second. At 15 fps and lower, the human eye can detect individual frames,
causing the video to appear jerky.

Frame Rate:
Frame rate (expressed in frames per second or FPS) is the frequency (rate expressed in Hz) at which consecutive
images called frames appear on display. The term applies equally to film and video cameras, computer graphics,
and motion capture systems. Common Frame Rate Examples: 24, 25, 29.97, 30, 50, 60.

Frequency:
The number of audio cycles per second, expressed in hertz (Hz). Frequency determines the pitch of a sound.

-G-

Gamma:
A measurement of the intensity of mid-tones in an image. Adjusting the gamma adjusts the level of the mid-tones
while leaving the blacks and whites untouched.

GPU:
Graphics processing unit. A microprocessor with built-in capabilities for handling 3D graphics more efficiently
than a CPU (central processing unit).

Gravity:
Gravity in OpenShot is a property of each clip that sets the clip’s initial position on the screen.

Green screen
A green background that the subject stands in front of that is another background in post-production.

Green Screen Compositing
The process of making all green elements in an image transparent and placing a different background underneath,
so it appears that the subject is in a different location.

-H-

High Definition (HD):
A general term for a video signal with a significantly higher resolution than standard definition.

HDMI:
High Definition Multimedia Interface. Interface for transmitting high definition digital audio and video data.

HDR:
HDR (high dynamic range) is the compositing of two images, one that correctly exposes the highlights, and
another that properly exposes the dark areas. When composited together, you get a properly exposed image.
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HDTV:
High Definition TV. A broadcast format that allows for a higher resolution signal than the traditional formats,
NTSC, PAL, and SECAM.

HDV:
High Definition Video. The format used to record HDTV-quality data with video camcorders.

Headroom:
The space between the top of a character’s head and the top of the frame.

Hiss:
Noise caused by imperfections in the recording medium.

Hue:
The shade of a color. This is the general color category into which the color falls. For example, pink, crimson,
and plum are different colors, but they all fall under the hue of red. White, black, and gray tones are not hues.

-I-

Image Stabilizer:
Also referred to as an electronic image stabilizer. A technique used to remove the movement caused by camera
shake.

Importing:
Importing is the process of transferring videos from your camera onto your computer or into a piece of editing
software.

Interframe Compression:
A compression scheme, such as MPEG that reduces the amount of video information by storing only the differ-
ences between a frame and those preceding it.

Interpolation:
Used in animation to calculate the motion in between two user-generated keyframes so that the editor does not
need to animate each frame manually. This speeds up the process and makes the resulting animation smoother.

Intertitles:
Titles that appear on their own between footage. Commonly seen in silent movies to substitute dialogue, also
used as chapter headings.

-J-

J-Cut:
An edit in which the audio starts before the video, giving the video a dramatic introduction. Also known as an
audio lead.

Jog
To move forward or backward through video by playing it one field or frame at a time.

Jump Cut:
A jump cut is an unnatural, abrupt switch between shots identical in the subject but slightly different in screen
location, so the subject appears to jump from one screen location to another.
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-K-

Key:
A method for creating transparency, such as a bluescreen key or a chroma key.

Keyframe:
A keyframe is a frame that contains a record of specific settings (e.g., scale, rotation, brightness). Start and
endpoints for animated effects. By setting multiple keyframes, you can adjust these parameters as the video
plays to animate certain aspects.

-L-

L-Cut:
An L-cut is an edit in which the video ends before the audio. L-cuts act as a subtle transition from one scene to
the next.

Letterbox:
A technique used to preserve the original aspect ratio of a motion picture when played on a TV. Letterboxing
adds black bars to the top and bottom of the screen.

Linear Editing:
A form of video editing which lays out cuts sequentially, one by one, to produce the final scene. This contrasts
with non-linear editing which allows cutting in any order.

Log:
A record of start and end timecode, reel numbers, scene descriptions, and other information for a specified clip.

Lossless:
A compression scheme that results in no loss of data from decompressing the file. Lossless files are generally
quite large (but still smaller than uncompressed versions) and sometimes require considerable processing power
to decode the data.

Lossy:
Lossy compression is a compression scheme that degrades quality. Lossy algorithms compress digital data by
eliminating the data least sensitive to the human eye and offer the highest compression rates available.

-M-

Mark In:
Placing a marker at the beginning of where you want your clip to start.

Mark Out:
Placing a marker at the beginning of where you want your clip to end.

Match Action:
Match action (or match cut) is a technique where an editor will cut from one visually similar scene to another.

Memory Bank:
A Memory Bank is a video that documents specific periods or events in someone’s life. It can be set to music,
make use of natural sound, record vacations, or just capture moments in everyday life.

Marker:
An object used to mark a location. Clip markers signify essential points within a clip. Timeline markers indicate
scenes, locations for titles, or other significant points within an entire movie. Use clip markers and timeline
markers for positioning and trimming clips.
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Mask:
The transparent area of an image, typically defined by a graphic shape or a bluescreen background. Also called
a matte.

Matte:
Matte is an image mask used in visual effects to control applying an effect to certain parts of the image.

Montage:
A montage is a self-contained sequence of shots assembled in juxtaposition to each other to communicate an
idea or mood. The implied relationship between seemingly unrelated material creates a new message.

Motion Artifact:
Visual interference caused by the difference between the frame rate of the camera and the motion of the object.
The most common display of this is when filming a computer or television screen. The screen flickers or a
line scans down it, which is the difference in frame rates and a lack of synchronization between the camera and
television.

-N-

Noise:
Undesired data in a video or audio signal. See also artifact.

Non-linear Editing:
An editing system that performs edits at any time, in any order. Access is random, which means that the system
can jump to specific pieces of data without having to look through the whole footage to find it.

Numerator:
The number or expression above the line in a fraction (such as 1 in ½).

NTSC:
NTSC is an abbreviation for National Television Standards Committee. NTSC is the group that initially devel-
oped the black & white and subsequently color television system. The United States, Japan, and many other
countries use NTSC. Five-hundred twenty-five interlaced lines make up NTSC that display at a rate of 29.97
frames per second. ATSC Has now superseded by NTSC.

-O-

Offline Editing:
Editing a rough cut using low-quality clips, and then producing the final cut with high-quality clips, usually on
a more sophisticated editing system than that used for developing the rough.

Online Editing:
Doing all editing (including the rough cut) on the same clips that produce the final cut.

Opacity:
An inverse measure of the level of transparency in an image, which is of importance when compositing. An
image’s alpha channel stores its opacity information.
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-P-

PAL:
PAL is an abbreviation for Phase Alternate Line. This is the video format standard used in many European
countries. Six-hundred twenty-five lines make up a PAL picture that displays at a rate of 25 frames per second.

Pan:
A horizontal movement of the camera on a fixed axis.

Pan and Scan:
A method of converting widescreen images to a 4:3 aspect ratio. Cropping the video so that it fills the entire
screen and panning it into position shows the essential parts of the scene.

Picture in Picture (PIP):
An effect of superimposing a small window of footage over a larger window and the two play at the same time.

Pixel:
One of the tiny dots that make up the representation of an image in a computer’s memory. The smallest unit of
a digital image.

Pixel Aspect Ratio:
Aspect ratio is the ratio between the width and height of your video; the Pixel Aspect Ratio is the ratio between
the width and height of the pixels. A standard Pixel Aspect Ratio is 1:1.

Pixelation:
The display of large, blocky pixels in an image caused by over-enlarging it.

Playhead:
When editing audio or video in a current computer, the Playhead is a graphic line in the Timeline that represents
the current accessed position, or frame, of the material.

Post-production (Post):
Post-production (post) is any video production activity following the initial recording. Typically, post involves
editing, the addition of background music, voice-over, sound effects, titles, and various visual effects resulting
in completed production.

Poster Frame:
A single frame of a clip, selected as a thumbnail to indicate the clip’s contents.

Project:
A project is all the files, transitions, effects, and animations that you make or use within OpenShot.

-R-

Raw Footage:
Raw footage is pre-edited footage, usually direct from the camera.

Real-time:
Real-time occurs immediately, without delay for rendering. If a transition occurs in real-time, there is no waiting,
the computer creates the effect or transition on-the-fly, showing it the results immediately.

Rendering:
The process by which the video editing software and hardware convert the raw video, effects, transitions, and
filters into a new continuous video file.

Render Time:
The render time is the time it takes an editing computer to composite source elements and commands into a
single video file. Rendering allows the sequence, including titles and transition effects, to play in full motion.
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Resolution:
Resolution refers to the actual number of horizontal and vertical pixels your video contains. Common resolution
Examples: (SD) 640×480, (HD) 854x480, (HD) 1280×720, (FHD) 1920×1080, (QHD) 2560x1440, (UHD)
3840x2160, and (FUHD) 7680x4320. Often the numbers that appear vertically refer to the resolution. The
examples listed would appear as SD, 480p, 720p, 1080p, 1440p, 4K and 8K, respectively.

RGB:
Monitors, cameras, and digital projectors use the primary colors of light (Red, Green, and Blue) to make images.

RGBA:
A file containing an RGB image plus an alpha channel for transparency information.

Roll:
Roll is a text effect commonly seen in end credits, where text typically moves from the bottom to the top of the
screen.

Rough cut:
A rough cut is a preliminary edit of footage in the approximate sequence, length, and content of a finished
program.

-S-

Sample Rate:
In digital audio, the number of samples per second. The higher the number, the better the sound quality.

Scene:
Action that occurs in one location at one time.

Scrub:
Scrubbing is an act of moving the cursor or playhead across the Timeline manually. Once specific to audio tracks,
the term now also refers to video tracks.

Shot:
A recording of a single take.

Slow-motion:
A shot in which action takes place at a slower than average speed. The camera achieves slow-motion by speeding
up the frame rate during recording and then playing back the frames at a slower speed.

Snap:
Snapping quickly positions an object in alignment with grid lines, guidelines, or another object. Snapping causes
the object to automatically jump to an exact position when the user drags it to the proximity of the desired location.

Splice:
The process of physically attaching two pieces of film using tape or cement.

Split cut (L-cut or J-cut):
An edit in which the audio starts before or after the picture cut. Used for easing the transition from one scene or
shot to another.

Splitscreen:
A unique effect that displays two or more scenes simultaneously on different parts of the screen.

Sound Effects:
Sound effects are contrived audio, usually prerecorded, incorporated with a video soundtrack to resemble a real
occurrence. Blowing on a microphone, for example, might simulate wind to accompany hurricane images.

Soundtrack:
The soundtrack is the audio portion of a video recording, often multifaceted with natural sound, voiceovers,
background music, or other sounds.
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Stabilization:
Image stabilization is a family of techniques that reduce blurring associated with the motion of a camera or other
imaging device during exposure.

Standard Definition (SD):
Television broadcasting standard with a lower resolution than high definition.

Step:
The act of moving forward or backward through video one frame at a time.

Still Frame:
A single frame of video is repeated, so it appears to have no motion.

Straight Cut:
The most common edit, consecutive clips placed one after another in the Timeline window. Straight cuts are
preferable to transitions when the scenes are similar, and you do not want edits to be noticeable.

Superimposing:
Combining images, where one or more layers involve transparency.

Sync (Synchronization):
Synchronization refers to the relative timing of audio (sound) and video (image) parts during creation, post-
production (mixing), transmission, reception, and play-back processing.

SECAM:
Systeme Electronique Couleur Avec Memoire, a TV format used mainly in Eastern Europe, Russia, and Africa.

-T-

Tilt:
Tilting is a cinematographic technique in which the camera stays in a fixed position but rotates up/down in a
vertical plane.

Timecode:
The timecode is the discrete address given to each frame of the video (for example, 1:20:24:09). Timecode makes
frame-accurate editing possible and allows editors to identify scenes precisely in a log.

Time-lapse:
It is a technique for capturing each frame in a video at a much slower rate than usual. When played back at regular
speed, time appears to go by faster. An editing program achieves this by fast-forwarding or increasing the speed
of your video.

Timeline:
The Timeline is an editing interface that lays out a video project in a linear fashion consisting of clips laid
horizontally across the screen.

Timeline Editing:
Timeline editing is a computer-based method of editing, in which bars proportional to the length of a clip, rep-
resent video and audio clips on a computer screen.

Titling:
Titling is the process or result of incorporating on-screen text as credits, captions, or any other alphanumeric
communication.

Track:
A separate audio or video layer on a timeline.

Transcode:
Converting a digital file to another digital file format. This usually involves audio and video compression.
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Transparency:
Percentage of the opacity of a video clip or element.

Transition:
A method of juxtaposing two scenes. Transitions can take many forms, including cuts, dissolves, and wipes.

Trim:
Removing frames from the beginning, middle, or end of a clip.

-V-

Video Format:
The video format is a standard that determines the way a video signal records on videotape. Standards include
DV, 8-mm, Beta, and VHS.

Voiceover:
A term used to describe off-camera narration that is not part of a scene (non-diegetic).

VTR:
A Videotape recorder also referred to as a ‘deck’. Decks duplicate videotapes and inputting and outputting from
a computer.

-W-

Widescreen:
A format in which the width-to-height ratio of the frame is greater than 4:3 so that it is significantly wider than
it is tall.

Wipe:
A wipe is a transition from one shot to another. The edge of the transition moves across the original image as a
line or a pattern, revealing the new shot.

-Z-

Zoom:
A shot where the image grows more substantial or smaller by adjusting the focal length of the lens instead of
physically moving the camera.
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